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Chapter 1: Overview 

Over the last three decades, the biggest challenge of IT departments in many organizations has 

been transitioning to a paperless work environment. Seemingly, there has been tremendous 

success in this regard. Today, most transactions in the business world are performed 

electronically: 

§ Documents are written using word processing programs. 

§ Messages are sent via email. 

§ Inventories and purchases are tracked using Enterprise Resource Planning (ERP) systems. 

§ Medical information is stored in Electronic Medical Record (EMR) systems. 

Although these transactions are performed in a paperless environment, organizations have still 

not managed to find an easy way to get rid of the paper used for data authentication (signing 

the authenticity of the data). Today, although organizations have invested large amounts of 

funds and other resources in creating paperless environments, their workers are still printing 

every transaction, signing it, and saving the printed copy. These organizations require a digital 

method for data authentication. 

By moving to a viable electronic data authentication system, organizations can reduce their 

printing, archiving, shipping, and handling costs. In addition, better and more competitive 

customer service can often be provided. 

Requirements for Data Authentication Systems 

A viable data authentication system must meet the following specifications: 

§ Security ï The system must ensure that no one other than the data creator can tamper with 

or change the data in any way. 

§ Third-party validation ï The system must enable any third party to validate the 

authenticity of the data. If a dispute arises between the parties (the data creator and 

recipient), any third party must be able to validate the data authenticity in order to settle 

the dispute. 

§ System independence ï Data authentication must be independent of the system that 

created the data. Users must be able to validate the authenticity of the data using a known 

standard that is independent of any specific system. 

§ Validation over time ï Users must be able to validate data authenticity at any point in 

time. Authenticity cannot expire at any point. 

Currently, the only data authentication method known to support all of these requirements is 

the Public Key Infrastructure (PKI) method of authenticating data, simply called ñdigital 

signaturesò. 
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Introduction to CoSign 

CoSign is a PKI-based, off-the-shelf digital-signature solution that can be integrated with a 

wide range of applications. In this way, CoSign enables organizations to embed digital 

signatures in various documents, forms, and transactions. CoSign is a turnkey, hardware-based 

solution that is easily and quickly deployed in the network and provides cost-effective digital-

signature capabilities for the organization.  

CoSign includes all the components needed for PKI-based digital-signature deployment. You 

do not need to install any other device or integrate any other component for the system to 

work.  

CoSign integrates with leading user management systems, including Microsoft Active 

Directory, Novell NDS, and LDAP based environments. This integration ensures no overhead 

in managing the digital-signature system and signature credentials (i.e., the private keys that 

are needed in a PKI environment), solving one of the main problems of legacy digital-

signature systems. System managers, network managers, and end-users can continue to use the 

IT infrastructure in the same manner as before CoSign was installed. 

CoSign stores the signature credentials in a secure server, ensuring that the signer has 

exclusive access to his or her signature credentials, while still maintaining a centrally managed 

solution. This is necessary in order to fulfill the security requirement of the data authentication 

system. 

An increasing number of applications can work with CoSign as their digital-signature layer 

without needing any further integration, including: 

§ Microsoft Office 2010 (Word, Excel, and PowerPoint). 

§ Microsoft Office 2007 (Word, Excel, and PowerPoint). 

§ Microsoft Office XP/2003 (Word, Excel, and PowerPoint). 

§ Microsoft InfoPath 2007/2010. 

§ Adobe Acrobat. 

§ Microsoft SharePoint. 

§ XML files. 

§ TIFF files. 

§ Word Perfect. 

§ Microsoft Outlook and Outlook Express. 

§ Adobe Server forms (for signing web forms). 

§ AutoCAD. 

§ Lotus Notes. 

§ Microsoft BizTalk. 

§ FileNet eForms. 
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§ Verity Liquid Office. 

§ ERP systems (e.g., SAP). 

§ Crystal Reports. 

§ Web applications. 

§ Any application that has a print option can use CoSign to generate a PDF file and sign it. 

For information on using CoSign with other applications, contact ARX technical support. 

CoSign also leads the development of Signature API (SAPI), an API that enables application 

developers to easily integrate with CoSign. For more information about integrating with 

CoSign, refer to the CoSign Programmer Guide (SAPI). 

CoSign includes the following components:  

§ The CoSign appliance hardware and software, connected to the organizationôs network. 

For more information, refer to the chapter Installing CoSign in the CoSign Administrator 

Guide. 

§ The CoSign Client software, installed on the usersô computers. For more information, 

refer to Chapter 2: Installing. 

§ The CoSign Administrative software that includes the CoSign Microsoft Management 

Console (MMC) snap-in, installed on the administrative computer. For more information, 

refer to the chapter Managing the CoSign Installation chapter in the CoSign Administrator 

Guide. 

CoSign Guides 

CoSign documentation includes several guides: 

§ CoSign Administrator Guide ï Provides all the information necessary for an administrator 

to install and manage the CoSign appliance in the various environments in which CoSign 

can operate. 

§ CoSign User Guide ï Provides all the information necessary for an end user to use 

CoSign. Includes information about special add-ins for various applications such as 

Microsoft Office. 

The CoSign User Guide is only relevant when the CoSign client is used in conjunction 

with the CoSign appliance. 

§ CoSign Desktop User Guide ï Provides all the information necessary for using CoSign 

Desktop. Includes information about special add-ins for various applications such as 

Microsoft Office. 
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§ CoSign for SharePoint User Guide ï Provides all the information necessary for 

implementing and using the CoSign for SharePoint solution. 

§ CoSign Programmer Guide (SAPI) ï Provides all the information necessary for a 

developer to interact with CoSign. Three application interfaces (API) are available: 

§ An interface for C/C++ applications. 

§ An interface for COM based applications. 

§ An interface based on Web Services to be used by Application Servers. 

CoSign Appliance Hardware Models 

There are several available hardware models of the CoSign appliance. The models differ in 

functionality, as follows: 

§ CoSign Central Enterprise ï A rack-mountable industrial 1U appliance. This appliance is 

not packaged in a tamper-response casing. 

§ CoSign Central FIPS ï This rack-mountable 4U appliance is based on a sealed, tamper-

response casing. The hardware box is FIPS 140-2 level 3 validated. 

§ CoSign Central SSCD ï The CoSign SSCD is very similar to the CoSign Central FIPS 

model. The major difference is that all end usersô private keys are located inside an array 

of SmartCard chips and the RSA signature operation is performed inside a SmartCard. 

Each userôs key can be used only if a dedicated password is provided for accessing the 

key. Thus, the end userôs private key is considered more protected than in the CoSign 

FIPS model. 

The CoSign SSCD appliance provides a solution that is compliant with the Common 

Criteria SSCD protection profile (CWA-14169). 

§ CoSign Central Starter ï CoSign Central Starter is a digital-signature turnkey solution 

that meets the needs of smaller organizations. CoSign Central Starter is limited to 

organizations of no more than 50 users. 
 

Note: Throughout this guide, the term ñCoSignò refers to all hardware models (Central 

Enterprise, Central FIPS, Central SSCD, and Central Starter), and the CoSign Desktop 

model, unless otherwise noted. 
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Organization of this Guide 

This guide is organized as follows: 

§ Chapter 1: Overview ï Provides an overview and introduction to CoSign. 

§ Chapter 2: Installing ï Describes how to install the CoSign client, install plug-ins for 

Microsoft Office, Adobe Acrobat and TIFF, set graphical signatures, use CoSign Verifier, 

and more. 

§ Chapter 3: Using the CoSign Control Panel ï Describes how to use the CoSign Control 

Panel. 

§ Chapter 4: Using the Graphical Signature Management Application ï Describes how to 

manage graphical signatures using the Graphical Signature Management application. 

§ Chapter 5: Signing Microsoft Office Documents ï Describes how to generate and validate 

digital signatures for Microsoft Office applications, and how to integrate the digital 

signatures into the general application flow. 

§ Chapter 6: Signing InfoPath 2007/2010 Forms ï Describes how to generate and validate 

digital signatures for Microsoft InfoPath forms. 

§ Chapter 7: Signing Adobe Acrobat Documents ï Describes how to sign and validate an 

Adobe Acrobat document using Adobe Acrobat or Adobe Reader, as well as how to 

certify an Acrobat document. 

§ Chapter 8: OmniSign ï Signing PDF and non-PDF Files ï Describes how to use 

OmniSign to sign any printable data from any application. 

§ Chapter 9: The ARFileSign Utility ï Describes the arfilesign.exe  command line 

utility which can be used to digitally sign any PDF, XML, TIFF, Word/Excel 2007/2010, 

InfoPath 2007/2010 or Word 2003 file. 

§ Chapter 10: Signing WordPerfect Documents ï Describes how to generate and validate 

digital signatures using WordPerfect. 

§ Chapter 11: Signing Outlook Emails ï Describes how to generate and validate digital 

signatures using Microsoft Outlook and Microsoft Outlook Express. 

§ Chapter 12: CoSign Configuration Utility ï Describes how the CoSign Configuration 

Utility enables the user to set the configuration of any parameter in any of the CoSign 

client components. 

§ Chapter 13: Troubleshooting ï Offers solutions to various client-related problems you 

may encounter while running the CoSign Client. 

§ Index ï Provides a comprehensive index of the topics discussed in this guide. 
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Chapter 2: Installing 

This chapter describes how to: 

§ Install the CoSign Client. 

§ Install the ROOT certificate for validation purposes. 

§ Use CoSign Verifier to validate digital signatures that were attached to applications such 

as Office using CoSign. 

Note: The installation of CoSign differs slightly depending on whether it is being installed in 

a Microsoft Active Directory environment, Novell NDS environment, LDAP based 

environment, or a Directory Independent environment. These differences are mentioned where 

applicable. 

Installing the CoSign Client 

CoSign enables the end-user to digitally sign transactions, documents, and other types of data. 

In order to perform these tasks, the CoSign client must be installed. The CoSign client enables 

applications such as Microsoft Word to use CoSign for generating digital signatures. The 

following chapters provide information on generating signatures in third-party applications. 

The CoSign client may be installed on a machine using one of the following operating 

systems: 

§ Windows XP Professional. 

§ Windows 2003. 

§ Windows VISTA. 

§ Windows 7. 

§ Windows 2008, Windows 2008 R2. 
 

Note: The CoSign client can also be installed in any 64 bit variant of the above operating 

systems, such as Windows Vista 64 bit or Windows 7 64 bit. 
 

Note: You must have local administrative rights in order to install the CoSign client. 
 

Note: In Novell NDS, LDAP, or Directory Independent environments: If the CoSign internal 

CA is used for generating end userôs certificates, then the ROOT certificate must be manually 

installed on every workstation on which a CoSign client is installed. Refer to Installing the 

ROOT Certificate for Validation Purposes. 
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CoSign Client Components 

The CoSign Client CD displays a CoSign Client Components Installation screen when the 

CoSign Client CD is put into the CD driver. 

Each CoSign component is based on several .msi  files. The .msi  files are based on the 

Microsoft Software Installation technology.  

The components include: 

§ ARX CoSign Client  ï The standard CoSign client installation without any plug-ins.  

§ ARX CoSign Admin  ï Enables administrators to install and manage CoSign. The 

installation and management activities are described in Installing CoSign and Managing 

the CoSign Installation in the CoSign Administrator Guide. 

§ Microsoft Office (Word, Excel, InfoPath ) ï Three types of plug-ins are 

supported: 

§ ARX Signature Line Provider  ï A digital signature plug-in for Office 

2007/2010 for the .docx  and .xlsx  file types.  

§ ARX Legacy Word Add - in  ï A digital signature plug-in for Word 

XP/2003/2007/2010 and Excel XP/2003/2007/2010 that enables you to sign .doc  and 

.xls  files. 

For more information, refer to Chapter 5: Signing Microsoft Office Documents ARX 

OmniSign Printer  ï A plug-in for signing any printable data from any application. For 

more information, refer to Chapter 8: OmniSign ï Signing PDF and non-PDF Files. 

Installation Pre-requisites 

§ To perform signatures using Office 2007/2010 upon . docx  or .xlsx  files, it is 

mandatory to install .NET Framework version 2 or above in the client machine. The client 

installation prompts the end user to automatically install .NET framework 2 if it is not 

already installed. 

§ To perform signatures upon . docx  or .xlsx  files using SAPI, it is mandatory to install 

.NET Framework version 3 in the client machine. The installation is not performed 

automatically by the CoSign client installation and should therefore be performed by the 

user.  

§ To perform signatures upon .xml  files using SAPI, it is mandatory to install .NET 

Framework version 2 in the client machine. The installation is not performed 

automatically by the CoSign client installation and should therefore be performed by the 

user.  

§ To perform signatures upon InfoPath 2007/2010 files using SAPI, it is mandatory to 

install .NET Framework version 2 in the client machine. The installation is not performed 

automatically by the CoSign client installation and should therefore be performed by the 

user.  
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§ If you intend to use the ARX add-in for Microsoft Office, you should include the 

component called "Visual Basic for applications" when installing Microsoft Office. This 

component is included in the Microsoft Office installation by default. 

Installing the Client Directly from the CD 

To install the CoSign client directly from the CD: 

1. Insert the ARX CoSign CD into the CD drive. The following CoSign Client Components 

Installation screen appears:  

 

Figure 1  CoSign Client Components Installation Screen 

2. Select the components you wish to install, based on the designation of the current 

workstation. Keep in mind the following: 

§ The ARX CoSign Client component is always selected. 

§ If the workstation is an administrative workstation, select the ARX CoSign Admin 

component. 

§ If the workstation is a user workstation, select the applicable components (Microsoft 

Office or OmniSign Printer). 

 
Note: The Microsoft Office component is automatically selected if 

Microsoft Office is installed in the end-user machine. 

 
Note: The OmniSign Printer component installs a new virtual printer in 

the end-userôs machine. 

3. Click Install Now. 
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When installation is complete, a ã appears next to each of the installed components. In case of 

a failure, an X appears next to the relevant components and a summary information box 

appears. 

Alternatively, you can place the contents of the CoSign CD on the network so that end users 

can install the CoSign Client through the network. While this method eliminates the need to 

use the CD for each installation, it does not facilitate automatic installations of the software. 

Uninstalling the CoSign Client 

To uninstall the CoSign client locally: 

1. Open the Start menu and select Programs Ą ARX CoSign Ą Uninstall CoSign 

Components. 

2. A confirmation box appears. Click Yes to uninstall. The uninstalling process begins. 

3. When the CoSign Client is uninstalled from the workstation, a message box appears to 

inform you that the system finished uninstalling. Click OK. 

. 

Installing the ROOT Certificate for Validation Purposes 

This procedure for installing the ROOT certificate is not required in the following cases only: 

§ CoSign is installed in a configuration where an external CA is used, or certificates are 

issued automatically by a World Wide Verifiable CA. 

§ The organization is deploying a CoSign Verifier home page (refer to Validating 

Signatures Without CoSign). The end user already uses these pages to install the 

organization ROOT certificate. 

The sections below describe how to install the ROOT certificate. 

An end user in an organization without CoSign who wishes to validate signatures that were 

originated by CoSign, must obtain the ROOT certificate of the organization that signed the 

document. The ROOT certificate is a .cer  file that is installed on the end userôs workstation 

either automatically or manually by the end user.  
 

Note: If CoSign is installed as a subordinate CA, you must make sure that the ROOT CA 

certificate is installed in the end userôs machine. 
 

Note: Alternatively you can use the client configuration utility to download the CoSign ROOT 

certificate to a file. Use the Download CoSign CA Certificate option in the CA menu (refer 

to CoSign Configuration Utility Menus). 
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Installing the ROOT Certificate 

The ROOT certificate needs to be installed on the end userôs workstation to enable proper 

validation of signatures. There are two methods for installing the ROOT certificate: 

§ Direct installation. 

§ Adding the ROOT certificate to a trusted CA list in the Active Directory of the domain of 

the organization that does not have CoSign. For more information about this option, refer 

to the CoSign Administrator Guide. 

Direct Installation 

To install the ROOT certificate: 

1. On the end userôs workstation, double-click the .cer file and follow the instructions in the 

wizard that appears. 

2. When the Certificate dialog box appears, click Install Certificate (Figure 2). 

 

Figure 2  Certificate Dialog Box 

3. Click Yes in the Root Certificate Store dialog box. 
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Figure 3  Root Certificate Store Dialog Box 

The ROOT CA Certificate is installed on your PC, enabling you to validate signatures. 

For more information on how to automatically install the ROOT certificate, refer to the 

CoSign Administrator Guide. 

Validating Signatures Without CoSign 

If you are not using CoSign, you can still validate digital signatures that were attached to 

Microsoft Office documents using CoSign. To do so, you need to install the CoSign 

Verifier . 

The CoSign Verifier is installed using a self-extracting executable that can be downloaded 

from the web. It can be installed either by connecting to ARXôs web page at  

http://verify.arx.com or by connecting to the organizationôs web page, which you can set up as 

described in Installing the CoSign Verifier. 

Installation of the CoSign Verifier provides the following functionality: 

§ Installation of an Office verifier capable of verifying Word and Excel digital signatures. 

For more information on verifying Word or Excel documents, refer to Chapter 5: Signing 

Microsoft Office Documents. 

§ Installation of an organizational ROOT certificate. 

§ Automatically setting Adobe 6, 7, 8, 9, 10 configuration parameters to enable signature 

verification without having the end user manually set any parameters. For more 

information, refer to Chapter 7: Signing Adobe Acrobat Documents.  

 
Note: If you install the CoSign verifier from the www.arx.com site, the ROOT of the ARX 

CoSign trial is installed. It is therefore recommended to deploy the installation as part of 

the organizationôs web site, and use the organizationôs ROOT certificate. For more 

information about how to set up an installation that includes the organizationôs ROOT 

certificate, contact ARX. 

http://verify.arx.com/
http://www.arx.com/
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Note: If a World Wide verifiable external CA is used, there is no need to install the ROOT 

certificate since it is already installed in the verifierôs PC. 
 

 

Note: Validating a signature in Adobe Acrobat 6/7/8/9/10 does not require a plug-in, and is 

based on the internal digital signature functionality of Adobe Acrobat 6/7/8/9/10. 
 

Note: Validating a signature in Microsoft Office 2007/2010 does not require a plug-in, and is 

based on the internal digital signature functionality of Microsoft Office 2007/2010. 

Note: Validating a signature in Microsoft InfoPath 2007/2010 does not require a plug-in, and 

is based on the internal digital signature functionality of Microsoft InfoPath 2007/2010. 

The following sections provide information about how to install the CoSign Verifier from the 

web site.  

Installing the CoSign Verifier 

You can install the CoSign Verifier either with administrative rights or with user rights. It is 

preferable to have administrative rights, so that any verifying party can use the verifier 

functionality. 

Starting from CoSign Verifier version 5.2, you can install the verifier from any Web browser 

available, such as Internet Explorer, Firefox, Chrome or Safari. 

To install the CoSign Verifier: 

1. Click the CoSign Verifier deployment web page. For example, if you choose to download 

the CoSign Verifier from the ARX web site, go to http://verify.arx.com and click the link 

to download the CoSign verifier. 

A security warning window appears.  

2. Click Run in the security warning window. The installation self-extracts and the following 

window appears: 

 

Figure 4  Security Warning Dialog Box 

3. Click Run to continue with the installation. An installation window appears. 

 

 

 

http://verify.arx.com/


2 CoSign User Guide 

14 

When installation is complete, the installation window closes 
 

Note: There is an Adobe-only version of the verifier that only modifies the current userôs 

Adobe settings to enable using Adobeôs built-in verification capability for verifying digital 

signatures in PDF documents. This Adobe-only version modifies the Adobe settings (shown in 

Figure 80) in both Adobe Reader and Adobe Acrobat. After installing the Adobe-only version, 

you can use Adobeôs built-in verification capability to verify signatures. To install the 

Adobe-only version, go to http://verify.arx.com and click PDF Only. 

Uninstalling the CoSign Verifier 

In the case of a full verifier installation, there are two components that can be removed. Go to 

Add/Remove Programs or the Add/Remove features option in the Control Panel, and 

remove the following components: 

§ ARX Office Verifier 

§ ARX SAPI Verifier 
 

Note: If you installed the Adobe-only version of the verifier, no components need to be 

removed. 

 

 

 

http://verify.arx.com/
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Chapter 3: Using the CoSign Control Panel 

This chapter describes how to use the CoSign Control Panel, which enables you to operate the 

CoSign main components.  

Using the CoSign Control Panel 

All client-based operations are activated through the CoSign Control Panel. 

To access the Control Panel, you can either select StartĄ ARX CoSignĄ CoSign Control 

Panel or you can double-click the CoSign icon  in the tray. The CoSign Control Panel 

appears. 

  

Figure 5  CoSign Control Panel  

Some Control Panel options are always active, while others are active depending on the status 

of the CoSign appliance (Installed/Not Installed), the type of CoSign appliance installation 

(Microsoft Active Directory, Novell NDS, LDAP, or Directory Independent), or whether the 

CoSign client is in stand-alone mode (CoSign Desktop). 

CoSign Control Panel ï User Actions 

§ Client Configuration ï This option enables the end user to configure the CoSign client 

settings. For more information, refer to Chapter 12: CoSign Configuration Utility. 

§ Graphical Signatures ï This option enables both end users and administrators to manage 

personal graphical signatures. For more information, refer to Using the Graphical 

Signature Management Application. 

§ Change User Password ï This option is relevant only in the case of a Directory 

Independent environment. For more information, refer to CoSign Control Panel in a 

Directory Independent Environment. 
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§ OmniSign Settings ï This option activates the OmniSign application. For more 

information related to OmniSign, refer to Chapter 8: OmniSign ï Signing PDF and non-

PDF Files. 

§ Logoff ï This option logs off from the session. This option is relevant when CoSign is 

installed in a Directory Independent environment, Novell NDS environment, or any other 

configuration where the user needs to login manually. 

CoSign Control Panel in a Directory Independent Environment 

The following options are relevant in a Directory Independent environment: 

§ Client Configuration ï Refer to the explanation in CoSign Control Panel ï User Actions.  

§ Graphical Signatures ï Refer to the explanation in CoSign Control Panel ï User Actions. 

§ Change User Password ï Refer to the explanation in CoSign Control Panel ï User 

Actions. 

§ OmniSign Settings ï Refer to the explanation in CoSign Control Panel ï User Actions. 

§ Logoff ï Refer to the explanation in Changing the Password in a Directory Independent 

Environment. 

  

Figure 6  CoSign Control Panel ï Directory Independent Environment 

Changing the Password in a Directory Independent Environment 

To change your password when CoSign is installed in a Directory Independent 

environment: 

1. Click Change User Password in the CoSign Control Panel (Figure 6). 

The Change Password window appears. 
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Figure 7  Change Password in Directory Independent Environment 

2. Enter your user name. 

3. Enter the old password of the account and the new password of the account. Confirm the 

new password. 

4. Click Change password. 

CoSign Control Panel ï Administrator Actions 

For administrative operations, refer to the CoSign Administrator Guide. 

CoSign Control Panel Menu Bar 

The User, Designer and Admin options of the CoSign Control Panel menu bar display all the 

options that can be activated from the Control Panel.  

In addition, the Tools option includes two options: 

 

Figure 8  CoSign Control Panel Menu Bar  
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§ Options ï This enables you to configure CoSign Control Panel settings. When you select 

Options from the Tools menu, the following dialog box appears: 

 

Figure 9  CoSign Control Panel Settings 

§ Show CoSign Control Panel in system tray ï Check this option to display the 

CoSign Control panel in the system tray when the Control Panel is activated. 

§ Personal graphical signatures management ï In a regular client installation this 

option is always marked. When this option is checked, the graphical signature 

application is activated in user mode. If the option is unchecked and the CoSign 

administrative client is installed, the graphical signature application will operate in 

administrative mode. For more information, refer to Using the Graphical Signature 

Management Application. 

§ Refresh panel ï This option updates the icons in the control panel according to the 

updated state of the CoSign appliance. 

CoSign Control Panel ï Tray Item 

The CoSign control panel icon appears in the tray if the option Show CoSign Control Panel 

in the system tray is selected. Right-click the icon to display a popup that enables you to 

perform the following operations: 

§ Open control panel ï Maximizes the control panel. 

§ Change password ï Relevant only for a Directory Independent environment. 

§ SSCD Key Enrollment ï Relevant only for a CoSign SSCD appliance. The Activate Your 

Default Signing Key window appears (Figure 11). Refer to the instructions following 

Figure 11. 

§ Logoff ï Relevant only if the user is prompted to authenticate in a Directory Independent 

environment, or is configured to prompt for logon. 

§ Exit ï Closes the CoSign control panel. 



Using the CoSign Control Panel 3 

 19 

Operating the Control Panel for a CoSign SSCD Appliance 

When CoSign SSCD hardware is used, the procedure of generating a key and a certificate for 

a user is different from the one followed for a regular CoSign appliance. This is due to the 

requirement that only the end user can select the password that protects the userôs key.  
 

Note: Keep in mind that the passwords that protect each of the SSCD-based userôs keys are 

different from the password that protects the user account (Active Directory password, Novell 

NDS password, LDAP password, or Directory Independent password). 

To enable you to sign documents using an SSCD key: 

1. Upon user creation, either during installation or after the installation, the CoSign 

appliance generates a user account and sends you an email notification, directing you to 

enroll for a key. 

 

Figure 10  Request to Enroll 

2. Click Enroll. 

The Activate your Default Signing Key window appears. 
 

Note:  Alternatively, you can enroll by activating the CoSign Control Panel and clicking 

Activate your SSCD key. The Activate Your Default Signing Key window appears.  

In addition, when activating for the first time any application that can potentially sign using 

CoSign, the Activate your Default Signing Key window appears. 
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Figure 11  Activate Your Default Signing Key 

3. In the Activate your Default Signing Key window, enter the password that will protect the 

SSCD key, and confirm it. 

When you click OK, the key is generated inside the CoSign SSCD hardware. The CoSign 

appliance may also generate a certificate for you, depending on the certification model. 

You are informed that the key and certificate are ready for use and you can start signing 

documents. 

4. Whenever you use an SSCD key for a digital signature operation, you are prompted to 

enter a password.  

 

Figure 12  Password Entry When Signing with an SSCD Key 
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Updating SSCD Keys 

To update SSCD keys: 

1. Click Update your SSCD keys in the CoSign Control Panel.  

The Change password window appears. 

 

Figure 13  Change Password ï Updating SSCD Keys 

2. Enter a key in the Keyôs ID field. 

3. You can perform the following on the selected SSCD key: 

§ Change Password ï Enter the old password and the new password, and confirm the 

new password. 

§ Delete Key ï Click Delete to delete the selected SSCD key. If you wish to sign 

documents, you must enroll for a new key.  

 
Note: Deletion of an SSCD key does not automatically delete its matching 

certificate. 
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Chapter 4: Using the Graphical Signature Management 

Application 

This chapter describes how to use the Graphical Signature Management application, which 

enables you to set your graphical signature. The graphical signature can be embedded into the 

visible signature. 

 
Note: In this chapter the term ñCoSign Clientò refers also to the CoSign Desktop, unless 

otherwise stated. 

Overview 

The Graphical Signature Management application enables you to view all your graphical 

signatures and create a new graphical signature. This graphical signature can be attached to all 

Microsoft Word, Excel, InfoPath, TIFF, and Adobe Acrobat documents that you sign. 

There are several mechanisms that can be used for capturing a graphical signature: 

§ A capturing device such as Topaz pads or Interlink pads. 

§ A Mouse or a Tablet PC. 

§ A text-based graphical signature. 

§ An image uploaded from a file. 

The following section details how to capture graphical signatures. 

If you do not capture a graphical signature, a default graphical signature that is based on your 

name will be used by the signing application, such as Office 2007/2010 or OmniSign. 

The Graphical Signature Management application can be used in either of two modes of 

operation: 

§ Administrative Mode  ï An administrator station is used for creating the userôs graphical 

signatures, as follows: The user supplies his/her identity and password, after which the 

user can create and then view his/her own graphical signatures. 

§ User Mode ï The user can create or view his/her own graphical signatures. 
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Installing the Graphical Signature Capture Device 

The CoSign appliance is supplied with a graphical signature capture device. 

There are several types of graphical signature capture devices you can use: 

§ Graphical signature capture devices produced by Topaz Systems 

(http://www.topazsystems.com). Two models are available: 

§ SigLite LCD 1x5 USB ï This model includes an LCD capture device. The entered 

graphical signature appears on the LCD screen. 

§ SigLite 1x5 USB ï This model does not include an LCD capture device. 

 

Figure 14  SigLite LCD 1x5 USB 

§ Graphical signature capture devices produced by Interlink Electronics 

(http://www.interlinkelectronics.com). Two models are available: 

§ ePad-ink  ï This model includes an LCD capture device. The entered graphical 

signature appears on the LCD screen. 

§ ePad ï This model does not include an LCD capture device. 

http://www.topazsystems.com/
http://www.interlinkelectronics.com/
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Figure 15  ePad-ink  

 

Figure 16  ePad  

 

Note: Install the signature capture device only on machines in which the CoSign 

administrative client is installed. 

To install the graphical signature capture device: 

§ Connect the signature capture pad to the USB port on the workstation. The padôs drivers 

are automatically installed. 

Managing Graphical Signatures 

The Graphical Signature Management application enables you to create and manage graphical 

signatures. The graphical signatures you create using this utility are stored inside the CoSignôs 

users database as graphical objects.  

Starting from CoSign version 5.4, the Graphical Signature Management application can also 

manage graphical images that are located in the userôs local hard disk. This is mainly intended 
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for cases where the graphical image files are too big to be uploaded to the CoSign appliance. 

Using the Graphical Signature Management application, you can view the local graphical 

signatures, edit their attributes, and delete them. 

When you first run the Graphical Signature Management application, the following directory 

is created: <local hard disk> \ My Documents \ My Pictures \ My CoSign Images . 

In this directory the following sub-directories are created: 

§ WetInk 

§ Initials 

§ Logo 

You can place graphical signatures in each of these directories. These graphical signatures 

will appear in the Graphical Signature Management application, and can be managed by that 

application.  

To manage graphical signatures using the Graphical Signature Management 

application: 

1. Open the Start menu and select ProgramsĄ ARX CoSignĄ CoSign Control Panel, or 

you can double-click the CoSign icon  in the tray. The CoSign Control Panel appears. 

2. In the Control Panel, click Graphical Signature. The CoSign Graphical Signatures 

Viewer dialog box appears, for managing your graphical signatures. 

 

Figure 17  Graphical Signature Management Application  

3. Select a signature from the drop down list at the top of the window. The corresponding 

graphical image appears in the middle of the window. 

You can also use the left and right arrows to browse through all the available graphical 

signatures ï those stored in the CoSign appliance, and also those located in the local 

wetInk , Logo , or Initials  folders, under 

My Documents/ My Pictures/My  CoSign  images . 
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4. If you click Update Acrobat, you can define a new appearance with the name ARX 

Signature - <graphical signature label>, based on the graphical signature currently 

displayed. The appearance, which includes the graphical signature, can be selected in 

every Adobe signature operation (refer to Chapter 7: Signing Adobe Acrobat Documents). 

If the image is a logo, you can select this option to change the default logo in the existing 

Adobe Acrobat or Adobe Reader to the selected logo. 

5. If you click Download Images, you can download all your images that are stored in the 

CoSign appliance to the local disk. After clicking the link, you are requested to specify a 

local directory. Click OK to export all graphical signatures to the local directory you 

specified. Note that full signatures are saved to a Wetink  subfolder, initials to an 

initials  subfolder, and the logo to a logo  subfolder. 

6. If you click either New Signature or Edit Signature, the New Signature or Edit signature 

dialog box appears.   

      

Figure 18  New Signature and Edit Signature Dialog Boxes  

The display area displays the currently selected graphical signature. 

The following options are available: 

§ Signature Name ï Specify the name of the edited graphical signature. 

§ Image/Text Only ï Specify if the loaded graphical signature is based on an image or 

text. Depending on the selected option, the set of actions is different. Refer to 

Creating an Image-Based Graphical Signature and Creating a Text-Based Graphical 

Signature. 

§ Used For ï Specify the type of graphical signature: Full Signature, Initials, or Logo. 

Starting from CoSign version 5.4, a single logo is allowed per user. 

§ Select Color ï Specify the color of the foreground of the image. This is available for 

monochrome images. 
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§ Delete this signature ï Available in the Edit Signature dialog box only. The 

currently selected graphical signature is deleted.  
 

Note: A graphical signature is limited to 29KB. You can use up to a maximum of 140KB for 

your entire set of graphical signatures. 

If you wish to use a larger graphical image, you can store it in a local directory as described 

at the beginning of this section. Each local graphical signature is limited to 1 MB. 
 

Note: The first time you create a signature using a signature capture device, you must have 

local administrative rights. Afterwards, any user can create a signature. 
 

Creating an Image-Based Graphical Signature 

If you select Image in the Edit Signature dialog box (Figure 18), you can create an 

image-based graphical signature in any of the following ways: 

§ Upload any local image file to CoSign. Refer to Uploading an Image File. 

§ Create an image file and load it into CoSign. Refer to Creating an Image File. 

Uploading an Image File 

To load an image file into CoSign: 

1. Select Image in the Edit Signature dialog box (Figure 18). 

2. Click Upload.  

3. In the browse window that appears, browse to the desired image file. You can upload the 

following types of graphic files: monochrome bmp, multicolor bmp, or jpg. 

If the size of the image is larger than the maximal size allowed, it is automatically 

reduced. A window appears (Figure 19), asking whether to upload the reduced size image 

to the CoSign appliance. 

 

Figure 19  Reduce Graphical Image Dialog Box 
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Creating an Image File 

To create an image file and upload it into CoSign: 

1. Select Image in the Edit Signature dialog box (Figure 18). 

2. Click Create. A list of available image capturing techniques appears. 

 

Figure 20  Create a Graphical Signature ï List of Image Capturing Techniques 

Select an image capturing technique while keeping the following in mind:  

§ Topaz or ePad ï Use these options when it is required to enter the graphical signature 

using a signature capture pad. Use the pad as described in Installing the Graphical 

Signature Capture Device. If you are using a signature capture device with no LCD 

display, you will be able to see the signature only on the PC screen, while editing it. 

If you are using a signature capture device with an LCD display, you will be able to 

see the signature both on the device and on the PC screen while editing it. 

§ Tablet PC/Mouse ï Use a Tablet PC and a pen or a regular PC mouse to enter a new 

graphical signature. Any movement of the mouse or pen in the tablet PC is drawn in 

the Capture Signature window that appears.  
 

 
Note: You will be able to use the mouse on a regular PC only when using 

Vista or when Microsoft Office 2003/2007/2010 is installed. 

The display in the Edit Signature window refreshes (see Figure 21). 
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Figure 21  Creating a Graphical Image File 

3. Use the capturing technique to capture a graphical signature.  

4. When capturing is complete, click Done in the Edit Signature window (Figure 21). The 

graphical signature you created is uploaded into CoSign.  

5. If you wish to re-start the capture, click Clear. 
 

Note: If the size of the image is larger than the maximal size allowed, the image size is 

automatically reduced. 

Creating a Text-Based Graphical Signature 

To create a text-based graphical image: 

1. Select Text only in the Edit Signature dialog box (Figure 18). The options shown in 

Figure 22 appear. 
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Figure 22  Edit Signature Dialog Boxï Text-based Graphical Signature  

2. Click Font. A Font dialog box appears. 

 

Figure 23  Edit Signature Dialog Boxï Text-based Graphical Signature ï Defining the Text Appearance 

3. In the Font dialog box, specify the appearance of the graphical signature text (font, size, 

color, etc.).  

4. Click OK to close the Font dialog box. 

5. Using your keyboard, enter the text for the graphical signature. The signature is displayed, 

with the appearance you defined, in the window of the Edit Signature dialog box 

(Figure 22).  
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Using the Signature Designer Utility 

The Signature Designer utility enables you to merge several images into a unified graphical 

signature that can later be uploaded to the CoSign appliance. The utility provides basic design 

tools to enable this integration. The utility is useful, for example, if you wish to create a 

graphical signature that includes both a stamp and your signature.  

To use the CoSign Signature Designer: 

1. Select Start Ą Programs Ą ARX CoSign Ą CoSign Signature Designer. The utility 

appears.  

 

Figure 24  CoSign Signature Designer 

2. Select File Ą Import to import an image into the work area. A file selection window 

appears. Select a file of type BMP, JPG or GIF. 

The image appears as a rectangle in the upper left corner of the work area. 

3. Optionally move the image, or resize it: 

§ To move the image, click inside the image and drag. 

§ To resize while maintaining proportions, click and drag a corner. 

§ To stretch a side, click and drag a handle in a side. 
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As you manipulate the image, you can use the status bar to gain information about the 

image size and location. The leftmost pane displays the x,y location of the top-left corner 

of the currently selected image. The pane second from the left displays the width and 

height, in pixels, of the currently selected image. 

4. Repeat steps 1-2 to import and manipulate additional images, if desired. Each image you 

import is maintained as a separate graphic element until you save the work area, so you 

can manipulate it separately. 

5. If you have multiple images in the workspace, you can perform the following on any one 

of them, using the imageôs right-click menu: 

§ Bring To Front Ą Bring To Front ï Place the selected image in front of the image 

that is right in front of it. 

§ Bring To Front ĄBring Forward ï Place the selected image in front of all the 

images. 

§ Send To Back Ą Send To Back ï Place the selected image behind the image that is 

right behind it. 

§ Send To Back Ą Send Backward ï Place the selected image behind all the images. 

§ Transparency Level ï Set the transparency level of the selected image (between 

0 - 100%). A higher value sets higher transparency. 

§ Clear Image ï Delete the image from the work area. 

6. Optionally crop the display in the work area, as follows: 

a. Click  and with the mouse mark a region in the work area that you wish to save. 

The right-most pane in the status bar shows the width and height, in pixels, of the 

selected region. Optionally move the image, or resize it.  

b. Click  again to exit selection mode. 

c. Click . The area outside the selected region is cleared.  

7. At any point, you can view the pane second from the right in the status bar for information 

about the width and height, in pixels, of the work area display.  

8. When you finish modifying the display in the work area, click  to save the display in 

the work area as an image. A file selection widow appears. Specify the file type (either 

JPG or BMP), and specify a name and path for the file.  
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CoSign Signature Designer Menu Options 

The CoSign Signature Designer menu includes the following options: 

Menu Item Option Description 

File New Create a new work area. 

 Import Import a new image into the work area. 

 Clear All Clear the entire work area. 

 Save Save the current display in the work area as a JPG or BMP file.  

During the save, empty space surrounding the display is cropped out. 

 Save As Similar to Save. 

 Exit Exit the utility. 

Help About Displays information about ARX, and a link to the ARX web site. 

CoSign Signature Designer Toolbar Options 

The CoSign Signature Designer toolbar includes the following options: 

Button Description  

 Create a new work area. 

 Save the current display in the work area as a JPG or BMP file. 

During the save, empty space surrounding the display is cropped out. 

 Activate/deactivate the Select Region option: 

Click once to activate the Select Region mode, and mark with the mouse a region in the 

work area that you wish to save. You can move the image, or resize it.  

Click again to exit from the Select Region mode. 

 Crop the display to the selected region. 

 
Clear the entire work area. 
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CoSign Signature Designer Status Bar Information 

The four panes in the status bar provide the following information: 

Pane Location Description  

Left most x,y location of the top-left corner of the currently selected image. 

Second from left Width and height, in pixels, of the currently selected image. 

Second from right Width and height, in pixels, of the work area display. When you save, this will be 

the size of the saved image. 

Right most Width and height, in pixels, of the selected region. This is relevant when the 

Select Region tool is used. 
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Chapter 5: Signing Microsoft Office Documents 

CoSign enables generating and validating digital signatures for Microsoft Office applications, 

and integrating the digital signatures into the general application flow. CoSign supports 

integration with the following applications: 

§ Office 2010 documents ï Refer to Signing Office 2007/2010 Documents ï New Document 

Style. 

§ Office 2007 documents ï Refer to Signing Office 2007/2010 Documents ï New Document 

Style. 

§ Word XP and Word 2003 ï Refer to Signing Word and Excel Documents ï Office 

XP/2003 Style. 

§ Excel XP, Excel 2003 ï Refer to Signing Word and Excel Documents ï Office XP/2003 

Style. 

§ PowerPoint XP, PowerPoint 2003 ï Refer to Signing PowerPoint XP/2003 Documents. 

§ InfoPath 2003 ï Refer to Chapter 6: Signing InfoPath 2007/2010 Forms. 

 
Note: The term ñCoSign Clientò refers also to the CoSign Desktop, unless otherwise 

stated. 

Signing Office 2007/2010 Documents ï New Document Style 

CoSign enables you to add digital signatures, as well as graphical signatures, to .docx  and 

.xlsx  Office 2007/2010 documents using a special plug-in called ARX Signature Line 

Provider. To enable the plug-in, you must install the ARX CoSign Client  and ARXôs 

Microsoft Office (Word, Excel ) client components. For information on installing 

these components, refer to Installing the CoSign Client. 

The signing process and the configuration of its various options are performed using the ARX 

Office Signatures Line Provider. This provider fits into the signature line provider concept in 

Office 2007/2010.  

The basic signing process consists of placing signature place-holders (or signature fields) in 

the desired locations in the document, and signing each field. After signing, you can validate 

the signatures. Validation assures you that the document was not modified after it was signed 

and that a trusted CA approved the signersô certificates. 

You can also activate the ARX Legacy Word Add-in plug-in on pre-2007 .doc or .xls files 

when using Office 2007/2010. For more information, refer to Signing Word and Excel 

Documents ï Office XP/2003 Style. 
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Adding Signature Fields in Office 2007/2010 

Use the Insert tabôs special Signature Line option to add a new signature field (refer to 

Figure 25). Click ARX CoSign Signatures Add-in for Office. 

 

Figure 25  Selecting the ARX CoSign Signatures Add-in for Office 

A new signature field is generated and embedded inside the Office 2007/2010 document. 

 

Figure 26  Creating a New Signature Field in an Office 2007/2010 Document 

You can perform several operations on this field using the right-click menu, as shown in 

Figure 27. 

 

Figure 27  Signature Field Right-Click Menu Options in Office 2007/2010 
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The following two operations are relevant to an empty signature field: 

§ Sign ï Performs the digital signature on the empty signature field. Refer to Signing Empty 

Signature Fields in Office 2007/2010 for a full description of the digital signature 

operation. 

§ Signature Setup ï Refer to Configuring Signature Settings in Office 2007/2010.  

All other operations in the right-click menu are applicable to the empty signature field object 

and are standard Office 2007/2010 operations for displayable objects. 

Configuring Signature Settings in Office 2007/2010 

The following sections describe how to configure signature settings in Office 2007/2010. 

CoSign Signature Setup in Office 2007/2010 ï General Settings 

When you select Signature Setup from the right-click menu of a signature field (refer to 

Figure 27), the CoSign Signature Setup dialog box appears, with the Settings tab displayed. 

 

Figure 28  CoSign Signature Setup in Office 2007/2010 ï Settings Tab 

This dialog box enables you to define several parameters of the signature field. Some of these 

parameters will be displayed in the signature field and others are used during future signature 

operation. The parameters include: 

§ Suggested signer ï The name of the person who is required to sign this signature field. 

This parameter is displayed as part of an empty signature block. 

§ Suggested signerôs title ï The role of the person who is required to sign this signature 

field. This parameter is displayed as part of an empty signature block. 

§ Suggested signerôs e-mail address ï The email address of the person required to sign 

this signature field. 

§ Instructions to the signer ï The text displayed to the signer during the Sign operation. 
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§ Allow the signer to add reason in the Sign dialog ï If this option is selected, the signer 

will be able to add a reason. If you wish this reason to display in the signature field, check 

the Show Reason field in the Advanced tab. 
 

 
Note: Some of the parameters in the Settings tab can be used to enable SAPI to locate a 

certain signature, providing the ability to perform digital signatures through SAPI. 
 

 
Note: If you want the CoSign Signature Setup dialog box to appear on creation of each 

signature field, refer to Setting Microsoft Office Configuration. 

CoSign Signature Setup in Office 2007/2010 ï Advanced Settings 

 

Figure 29  CoSign Signature Setup in Office 2007/2010 ï Advanced Tab 

The Advanced tab of the CoSign Signature Setup dialog box includes the following 

parameters: 

§ Date and Time Format ï Set the displayed format of the signature date and time. 

§ Show ï Specify whether to display elements in the graphical signature such as Date and 

time, Reason, Signed by, Title, and Logo. 

A single graphical signature can be displayed and you can select whether this graphical 

signature is a regular graphical signature or Initials. 

Signing Empty Signature Fields in Office 2007/2010 

You can sign the content of an Office 2007/2010 document by right-clicking an empty 

signature field and selecting Sign from the right-click menu. After performing the Sign 

operation, nothing can be changed in the document except that other users can sign other 

empty fields inside the document. 
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Starting from CoSign version 5.4, a standard signing ceremony is used for the purpose of 

collecting the information required for the digital signature operation. This includes creating 

or editing a graphical signature, if desired. 

To sign the content of an Office 2007/2010 document:  

1. Right-click an empty signature field and select Sign from the right-click menu. 

The Signing Ceremony dialog box appears. Starting from CoSign version 5.4, the signing 

ceremony dialog is identical for all CoSign applications.  

 

Figure 30  Standard Signing Ceremony Dialog Box 

The dialog box may contain some or all of the following sections: 

§ Graphical signature selection ï In the upper section of the dialog you can specify the 

graphical signature that will be embedded inside the digital signature. If you select to edit 

the graphical signature or create a new one, a dialog of the graphical image utility appears 

(Figure 18). For explanations, refer to the explanations following Figure 18. 

The only difference is that in the New Signature dialog box you can choose to use a one-

time graphical signature (Figure 31). The one-time graphical signature will be used only 

for this specific digital signature operation and will not be kept in the CoSign appliance or 

CoSign software token/MiniKey. 
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Figure 31  New Signature Dialog Box with One-Time Signature Option 

§ Reason ï If a Reason field is displayed, select a reason from the predefined list or enter 

you own specific reason for this signature operation.  

Starting from CoSign version 5.4, the list of predefined reasons is identical for all the 

CoSign add-ins. This list is based on a default list that can be edited by an administrator 

using the configuration utility (refer to Signature API ï Reasons). If a user enters a new 

reason, all current reasons are in the ownership of the user and maintained locally in the 

userôs PC account. 

If you click Reset, you revert to the list of reasons administrated using the configuration 

utility . 

§ Title ï If a Title field is displayed, enter the title of the signer. 

§ Change ï Clicking this link enables you to select the certificate to be used as part of the 

digital signature operation. The common name of the signer, as taken from the certificate, 

is displayed on the same line as the link. 

A digital signature operation is performed using the CoSign appliance or software 

token/MiniKey, based on parameters that were defined in the Sign this document dialog box 

(refer to Figure 30) and the CoSign Signature Setup dialog box (Figure 28).  

The following figure shows a sample outcome of the digital signature operation. 

 

Figure 32  Sample Digital Signature in Office 2007/2010 
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In this example, the top right of the digital signature includes the signature date and time. The 

center of the graphical signature includes the selected graphical signature. If a graphical 

signature was not selected, the signerôs name is displayed in a special script font. The reason 

is displayed beneath the signature line, as well as the signerôs name if an image was selected. 

The following figure shows an invalid digital signature. 

 

Figure 33  Sample Invalid Digital Signature in Office 2007/2010 

 

 
Note: It is possible to generate an invisible digital signature. Refer to the SAPI 

documentation for information on how to generate an invisible digital signature. 

Validating and Viewing Digital Signatures in Office 2007/2010 

In an Office 2007/2010 document (.docx  or .xlsx  file), the visual display of the digital 

signature indicates the validity of the digital signature. If an existing digital signature is 

invalid, it will be indicated in the document. 

The following options are available when you right-click a signed digital signature field: 

 

Figure 34  Signed Digital Signature Field Right-Click Options 

§ Signature Details ï Displays information related to the digital signature and the signerôs 

certificate, as shown in Figure 35. 
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Figure 35  CoSign Signature Details in Office 2007/2010 ï Signature tab 

§ Signature Setup ï Displays signature setup without the ability to modify the values. The 

fields you can view are described in Configuring Signature Settings in Office 2007/2010. 

§ Remove Signature ï Enables the user to remove the signature. After this operation is 

acknowledged, the empty signature field is displayed. 
 

 
Note: The option Sign Again is not relevant for the ARX Signature Line Provider. 

Digital signatures are also listed in a special list of digital signatures that appears to the right 

of the document. To display the digital signatures list, either select the Prepare/View 

signatures option from the main icon of Office 2007/2010, or select the digital signature seal 

indication in the lower left side of the Office window. 

The digital signature seal indication appears only if there is a signature inside 

the document.  

In the list you can see all unsigned signature fields and existing digital signatures of the 

document. The right-click options available in the list are the same as those available by 

right-clicking a digital signature or empty signature field inside the document. 

Validating Digital Signatures without Using the ARX Signature Line Provider  

Digital signatures that were attached using CoSign in Office 2007/2010 can be validated 

without using CoSign. This is useful if you receive documents from a company or 

organization that uses CoSign internally.  

If the signerôs certificate was created by a Worldwide verifiable CA, you need not perform 

any action prior to the validation process. 

To validate signatures: 

1. Obtain the organizationôs ROOT CA Certificate (.cer  file) from a reliable representative 

of the organization using CoSign. 
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2. Install the organizationôs ROOT CA Certificate. 

Alternatively, install the organizationôs ROOT CA Certificate using the CoSign Verifier 

software. 

 
Note: If an external CA is used, or the CoSign certificate is based on a Worldwide 

verifiable CA, there is no need to install the ROOT certificate. 
 

 
Note: An installation of a ROOT CA certificate is not required in a CoSign 

Desktop installation. 

3. Validate the signature (refer to Validating Signatures).  

 
Note: Although you are able to view the digital signature, you cannot activate the 

Signature Settings and Signature Details options. Microsoft Office will validate the 

digital signature and display the valid/invalid image according to the validity of the 

digital signature. 

Using the ARX Office 2007/2010 ï CoSign Signatures Toolbar (Ribbon) 

The ARX Office 2007/2010 Signature Line Provider includes a Toolbar (Ribbon) that 

provides the following functionality: 

§ Sign ï Performs a ñOne Touch Signingò operation. This option creates a new signature 

field in the cursor location and performs a signature operation on the new field. Refer to 

Adding Signature Fields in Office 2007/2010 and Signing Empty Signature Fields in 

Office 2007/2010. 

§ Add Signature Field ï Creates a new signature field in the cursor location. Refer to 

Adding Signature Fields in Office 2007/2010. 

§ Help ï Displays the CoSign help module. This option is similar to selecting Help in the 

ARX Legacy Add-in. 

§ About ï Displays the CoSign Signature Line Provide About window. The window lists 

the current version of the ARX Signature Line Provider and some general ARX 

information. 

 

Figure 36  ARX Office 2007/2010 Signature Line Provider Toolbar (Ribbon) 
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Signing Word and Excel Documents ï Office XP/2003 Style 

CoSign enables you to add digital signatures, as well as graphical signatures, to Word and 

Excel documents in Office XP, Office 2003, Office 2007 and Office 2010, using the ARX 

Legacy Word Add-in plug-in. To enable the plug-in, you must install the ARX Microsoft 

Offic e component . 

 
Note: The ARX Legacy Word Add-in for XP/2003 and ARX Legacy Excel Add-in for 

XP/2003 are relevant also for Word and Excel 2007/2010, unless otherwise stated. Thus, 

you can use the ARX Legacy Word Add-in and ARX Legacy Excel Add-in for .docx and 

.xlsx files, in addition to.doc  and .xls  files. 

Overview  

The signing process and the configuration of its various options are carried out using the ARX 

Legacy Word Add-in menu or toolbar, and the signaturesô right-click menu.  

The basic signing process consists of placing signature place-holders (or signature fields) in 

the desired locations in the document, and signing each field. After signing, you can validate 

the signatures. Validation assures you that the document was not modified after it was signed 

and that a trusted CA approved the signersô certificates. 

During the signing phase, entering Design mode provides the options of changing the size, 

location, and layout of signature fields, as well as deleting signature fields from the document. 

You can optionally create a chronological dependency between signatures in a document. In 

Independent mode, the order of signing is not important. In Dependent mode, an attempt to 

re-sign a signature invalidates all the digital signatures created after that signature.  

CoSign supports two types of signatures: content-based signatures, which sign the textual and 

other visible content of a document, and file-based signatures, which sign the entire file. In 

Word, both signature types are supported. In Excel, only content-based signatures are 

supported. 

If content-based signatures are used, you can either sign the entire content of the document or 

a certain section of the document. 

Section-based signing is highly suitable for workflow procedures where every signer fills in 

his/her relevant content and signs the relevant content as part of the workflow. 

The following sections describe the ARX Legacy Word Add-in menu and toolbar, followed by 

a detailed step-by-step explanation of the signing process, including sections with detailed 

explanations of the various options and dialog boxes. 

It is also possible to use the ARX Legacy Word Add-in in Office 2007/2010 on Word 2003 

documents. To do so, activate the Add-Ins tab in Word 2007/2010. Both the ARX Legacy 

Word Add-in menu and its toolbar will appear. 
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ARX Legacy Word Add-in Menu 

The ARX Legacy Word Add-in plug-in includes a CoSign menu that can be activated from 

the menu bar of the Office application. 

 

Figure 37  CoSign Menu 

The CoSign menu includes the following options: 

Menu Option Description 

Sign All -in-one signature operation. Generates a new empty digital signature field at the 

cursor location, and performs a signature operation on this newly generated field. 

Add Signature 

Field 
Inserts a new empty digital signature field at the cursor location. The field displays 

the text: ñCoSign Digital Signatureò.  

Design Mode Toggles in and out of Design mode. 

For more information, refer to Using Design Mode. 

View All 

Signatures 
Displays signatures attached to the document.  

For more information, refer to Viewing the Signatures List. 

Validate All 

Signatures 
Checks the validity of all existing digital signatures, and updates the images of the 

signatures according to their validity status. 

Clear All 

Signatures 
Removes all digital signatures but keeps the digital signature fields. 

Configure 

Signature 

Defaults 

For more information, refer to Default Signature Settings ï General Parameters. 

Toolbar 

Settings 
Configures which buttons are displayed in the ARX Office toolbar. 

Refer to Configuring the ARX Legacy Word Add-in Toolbar. 

Help Displays this chapter in on-line Help format. 

About Displays version information about the ARX Legacy Word Add-in, and a link to the 

ARX web site. 
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ARX Legacy Word Add-in Toolbar Options 

ARX Legacy Word Add-in includes a Digital Signatures toolbar with the following buttons: 

Button Task 

 Toggles in and out of Design mode. 

For more information, refer to Using Design Mode. 

 All -in-one signature operation. Generates a new empty digital signature field at the cursor 

location and performs a signature operation on this newly generated field. 

 Inserts a new empty digital signature field at the cursor location. The field displays the text: 

ñCoSign Digital Signatureò.  

 Displays signatures attached to the document.  

For more information, refer to Viewing the Signatures List. 

 Validate All signatures. 

Checks the validity of all existing digital signatures, and updates the images of the 

signatures according to their validity status. 

 Clear All signatures. 

Removes all digital signatures but keeps the digital signature fields. 

 Configure Signature Defaults. 

For more information, refer to Default Signature Settings ï General Parameters. 

 ARX Legacy Word Add-in Help. 

Displays this chapter in on-line Help format. 

 Displays version information about the ARX Legacy Word Add-in, and a link to the ARX 

web site. 

Configuring the ARX Legacy Word Add-in Toolbar 

You can specify which buttons appear in the ARX Legacy Word Add-in toolbar. 

To specify which buttons appear in the toolbar: 

1. Select Toolbar Settings from the CoSign menu. 

The Select Buttons dialog box appears.  
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Figure 38  Select Buttons Dialog Box 

2. Check the boxes corresponding to the toolbar buttons you wish to display. 

3. Click OK. 

 
Note: In Office 2007/2010, both the toolbar and the CoSign menu are located inside the 

Add-ins ribbon. 

Signing and Validating Signatures in Word and Excel Documents 

The following sections describe the basic signing process, which includes the following 

phases: 

§ Signing a document (refer to Signing a Document with a Digital Signature). 

§ Viewing signatures (refer to Viewing Digital Signatures). 

§ Validating signatures (refer to Validating Signatures). 

In addition, if you modify the document after signing it: 

§ Modifying a signed document (refer to Modifying Documents Containing Digital 

Signatures). 

Signing a Document with a Digital Signature 

To sign a Word or Excel document digitally, place digital signature fields in the desired 

locations, and sign each field. 

To place digital signature fields: 

1. Open the document you wish to sign.  

2. Position the cursor where you wish a signature to appear, and click . 

A digital signature field is created. The field displays the text ñCoSign Digital Signatureò. 
 

 
Note: To change the fieldôs size, location, or layout, switch to Design mode by 

clicking  in the toolbar. When you finish modifying the field, click  again to 

toggle out of Design mode since you cannot sign a document in Design mode. 
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3. Repeat step 2 for every signature field you wish to create. 
 

 Note: You can click  to generate a digital signature field and automatically 

perform a digital signature operation. 

 
Note: If you are signing an entire Word document using either a file-based or a 

content-based signature, keep in mind that after the first signature is generated, it is 

not possible to add new digital signature fields to the document. Therefore, make 

sure to first create all the desired digital signature fields before you begin the 

process of signing them. 

To sign each signature field: 

1. Right-click the signature field and select Sign from the right-click menu.  

The standard Signing Ceremony dialog box appears, enabling you to enter all signature related 

parameters. For a description and explanations, refer to Signing Empty Signature Fields in 

Office 2007/2010. 

 
Note: In Word, when using file-based signatures, if you are working with a new 

document, you are prompted to save it during the digital signature operation. 
 

 
Note: When you send a document to Print, all the signatures are automatically validated 

so that the printout will display the updated state of the signatures. 
 

 
Note: When using the ARX Legacy Add-in in Office 2007/2010, you cannot use a file-

based digital signature in a .docx formatted document. If you try to do so, an error 

message appears. 

Clearing or Deleting Digital Signatures 

You may wish to delete signature fields or clear the digital signatures inside them. 

To clear a digital signature from a digital signature field: 

1. Right-click the field, and select Clear from the right-click menu. 

The digital signature is deleted from the field. The field itself remains intact. 

To delete a digital signature field: 

1. Switch to Design mode by clicking  in the toolbar. 

2. Select the field and click Delete from your keyboard. 

The digital signature field is deleted from the document. 
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Viewing Digital Signatures 

Each graphical signature is displayed in the document along with one of the following 

validation symbols: 

§ ï Signature is validated. 

§   ï Signature is not validated. 

§ ï Signature needs to be validated, or is in an unknown state. 

If the signer has created a graphical signature inside CoSign and configured it to display a 

graphical signature (refer to Default Signature Settings ï General Parameters), the graphical 

signature is displayed on top of the validation symbol. 

 

Figure 39  Graphical Signature 

If the signer has not created a graphical signature, the name of the user is displayed on top of 

the validation symbol. 

 

Figure 40  Digital Signature without Graphical Signature 

If the following elements were selected in the Default Signature Settings dialog box, they will 

also appear in the signature field (refer to Default Signature Settings ï General Parameters). 

§ The signerôs common name. 

§ The date and time of the signature operation. 

§ The reason for the signature. 

 

Figure 41  Signature with Additional Details 
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Validating Signatures 

To validate a graphical signature attached to a document: 

1. Open the document. 

2. Right-click the signature and select Validate from the right-click menu. 

You can configure the ARX Office plug-in to perform an automatic validation of all digital 

signatures that exist inside the document. Refer to Setting Microsoft Office Configuration. 

For information on how to view the signaturesô status, refer to Viewing the Signatures List. 

Modifying Documents Containing Digital Signatures 

Modifying the signed data in a Word or Excel document invalidates all its relevant signatures 

(depending on the signature scope) and an   is displayed in each signature field. Refer to 

Word Specific Signing Features and Excel Specific Signing Features for more details about 

the different signing options in Word and Excel, which define the scope of the digital 

signature. 

If you attempt to save a file-based signed Word document that is modified, the following 

message appears, ñSaving will remove all digital signatures in the document. Do you want 

to continue?ò To delete the file based signatures and save the document, click Yes. 

Word Specific Signing Features 

The CoSign Client enables generating two new content-based types of signatures in Word 

documents, in addition to the file-based signature:  

§ Document content signature ï This is the new default signature. This signature signs the 

entire textual and visible content of the document, but not the entire file. 

This mode is recommended in document management systems to avoid file access or 

network access to the document file. 

§ Section based signature ï Signs only the content of a specific section in the document. 

This functionality is useful for Word documents that are based on workflow operations. 

Using section-based signatures, each signer edits and signs a specific section, in no way 

affecting the signatures on other sections. 

For backward compatibility, the file-based signature can also be used. 
 

 

 
Note: Currently, SAPI (CoSignôs signature API) supports only file-based signature 

operations on a given Word file. 

Excel Specific Signing Features 

In Excel, only content-based signatures are supported. File-based signatures are not supported. 

You can select both the scope (workbook, active sheet, or selected area), and the content 

within the scope that will be signed. 
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The different scopes include: 

§ Active sheet ï All the relevant content in the active sheet will be signed. Any change in 

the relevant content within the active sheet will invalidate the signature, while any change 

in other sheets will have no effect on the signature.  

This is the default value. 

§ Workbook ï All the relevant content in all the workbookôs sheets will be signed. Any 

change in the relevant content within any sheet of the workbook will invalidate the 

signature. 

§ Selection ï Only the relevant content in the cells of the selected area will be signed. Any 

change in the relevant content of any of the selected cells will invalidate the signature, 

while any change in other cells will have no effect on the signature. You must select the 

cells before signing the signature field, and you can only sign a single continuous 

selection, not multiple selections. 

 
Note: To view which selected area a specific signature applies to, right-click the 

signature field and select Show from the right-click menu. The signed cells are 

highlighted. 

The different values for the signature content include:  

§ Cell Values ï The values of the cells will be signed. 

§ Cell Formula ï The cell formula will be signed.  

 
Note: If the cell formula depends on other unsigned cells, then even if the values 

of those cells change and cause the selected cells value to change, as long as the 

formula remains the same, this change does not invalidate the signature. 

§ Cell Properties ï The following cell properties will be signed: font name, font style 

(indicating whether the text is bold or italic), font size, hide row, and hide column. 

Configuring Signature Defaults 

The Default Signature Settings dialog box enables setting defaults for the appearance and 

other parameters of the graphical signatures.  
 

 
Note: You can configure defaults using the CoSign Configuration Utility. Refer to 

Setting Microsoft Office Configuration. 

You can set general defaults for all signatures in a document, or configure a specific signature 

field. 

To configure signature defaults for all signatures in a document: 

§ From the Digital Signatures toolbar, click . 
 

 
Note: The new signature defaults only affect future signature fields, not existing 

ones. 
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To configure a specific signature field: 
 

 
Note: You can configure a specific signature field only if the field is empty. 

§ Right-click a signature and select Settings from the right-click menu. 

The Default Signature Settings dialog box includes the following tabs: 

§ Settings ï Enables setting general signature parameters. Refer to Default Signature 

Settings ï General Parameters. 

§ Time Format ï Enables setting date and time parameters. Refer to Default Signature 

Settings ï Date and Time Format. 

§ Scope of Signature ï Enables setting the different signing options for Word documents 

or Excel documents. Refer to Default Signature Settings ï Scope of Signature (Word) and 

Default Signature Settings ï Scope of Signature (Excel). 

§ Signature Policy ï Enables defining Signature operation policy. At this stage, you can 

only define who can clear an existing signature. Refer to Default Signature Settings ï 

Signature Policy. 
 

 
Note: The Microsoft Office Compatible Signature field in the Settings tab is enabled 

only in Word.   

Default Signature Settings ï General Parameters 

 

Figure 42  Default Signature Settings ï Settings Tab  
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In the Settings tab you can set the following signature default settings: 

§ Signature  

§ Dependent ï Specify whether the digital signature is dependent or independent. For 

more information on setting up dependent signatures, refer to Imposing Dependency. 

§ Microsoft Office compatible signature ï Relevant only to Word documents. If this 

option is set, the ARX Word add-in generates an XP compatible digital signature that 

can be validated in Word XP or Word 2003 without installing a plug-in. 

This option has differing functionality depending on the type of digital signature. If 

the digital signature is content-based then the ARX Word add-in generates an 

additional XP compatible signature. 

If it is a file-based digital signature, the generated digital signature is an XP 

compatible signature. Refer to Validating Signatures in Word Documents Without 

Using the ARX Legacy Word Add-in Plug-in. 

 

When using Office 2007/2010, keep in mind that there is a difference between 

signatures that are applied to .doc documents and signatures that are applied to .docx 

documents. This section is relevant only for .doc documents. In this case, the whole 

document is locked and therefore after performing such a signature, you cannot 

perform any modification to the document, including clearing the digital signatures. 

§ Show ï Specify which elements will appear as part of the graphical signature of the 

digital signature: 

§ Date and time ï Whether to display the date and time of the signature. 

§ Reason ï Whether to ask the user to enter a reason for the signature and then display 

the reason as part of the signature. 

§ Signed by ï Whether to display the signerôs name as listed in the signerôs certificate. 

§ Title ï Whether to ask the user to enter his/her title and then display it as part of the 

signature. 

§ Logo ï Whether to display a logo image. 

§ Graphical image ï Whether to display a graphical signature. If the user selects 

Initials, a set of initial is displayed. 

§ Field Style ï Specify the signature field style. 

§ Transparent ï Whether the visible signature is transparent. When a signature is 

transparent, the documentôs text underneath the signature text is not fully 

overwritten by the visible signature elements. 

Keep in mind that in order for this parameter to take effect, you should specify the 

In Front Of Text layout for the signature field (refer to Figure 48 in Using Design 

Mode). 

In addition, this setting will apply only to signatures generated after you set this 

setting. 

§ Captions ï Specify whether to display the title of the element, for the elements selected in 

the Show section. 
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§ Restore Defaults ï Click to restore all the default values. 

This field is available only when clicking  to configure defaults for all signatures in the 

document. 

Default Signature Settings ï Date and Time Format 

 

Figure 43  Default Signature Settings ï Time Format Tab 

In the Time Format tab you can set the following signature default settings: 

§ Format ï Use the drop-down lists to specify the desired Date Format and Time Format. 

The date and time format notation are explained in the dialog box. 

§ Display GMT Offset ï Specify whether to display the time zone of the signature operation 

in relation to GMT. 

 
Note: The signature time is taken from CoSign, while the time zone is taken from 

the local machine. 
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Default Signature Settings ï Scope of Signature (Word) 

 

Figure 44  Default Signature Settings ï Scope of Signature Tab (Word) 

In the Scope of Signature tab that appears in Word, you can set the following signature 

default settings: 

§ Scope ï Specify the content to be signed:  

§ Entire File ï The Word file itself is signed.  

You can specify whether the created signature will be compatible with 

SharePoint 2007 by selecting the SharePoint 2007 Compatible checkbox.   

§ Document Content ï All the text and visible content of the document is signed. 

§ Containing Section ï The content of the current section is signed. Select this option 

if you intend to use section-based signing. 

§ Section Number ï The content of the specified section is signed. Select this option if 

you intend to use section-based signing. This option is used in cases where the 

document has a special page that contains digital signatures for sections that appear in 

other locations in the document.  

§ In addition to text, signature applies to ï Enables specifying that additional information 

be signed in the case of a content-based signature. 

§ Location & Size of Tables and Objects ï The location and size of tables and objects 

within the scope of signature are also included in the digital signature. This may cause 

a signature validation failure if content changes. 
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§ ActiveX Properties ï Information related to ActiveX objects embedded into the Word 

document. If this option is not selected, all  ActiveX information (such as ActiveX 

identification) will not be included in the digital signature. 

If this option is selected, limited information about the ActiveX object will be 

included in the digital signature. 

§ Field codes ï Field codes are text fields that are updated automatically, such as Date 

and Header/Footer information. If this option is not selected, the signing process 

includes the dynamically changing values of the field codes. This may cause a 

signature validation failure if the values change. 

If this option is selected, the signing process includes the field codes, but not their 

dynamically changing values. It is therefore recommended to leave this option 

selected. 

§ Form Fields & Content Controls ï The signing process includes form fields and 

content controls. This may cause a signature validation failure if content changes. 

Default Signature Settings ï Scope of Signature (Excel) 

 

Figure 45  Default Signature Settings ï Scope of Signature Tab (Excel) 

In the Scope of Signature tab that appears in Excel, you can set the following signature 

default settings: 

§ Scope ï Specify the cells to be signed:  

§ Active sheet ï All the relevant content in the active sheet will be signed. 

§ Workbook ï All the cells in the workbook will be signed. 
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§ Selection ï Only the cells of a specific selected area will be signed. There are two 

ways for specifying the selected area to be signed: 

§ Specify the top left and the bottom right cells of the desired area, separated by a 

colon, in the selection field. Refer to Figure 46 for an example.  

In this case the signer merely right-clicks and signs the signature field. 

 

Figure 46  Default Signature Settings ï Scope of Signature Tab (Excel) ï Selection Field Values Example 

§ If no selection is specified in the selection field, the signer selects the cells to be 

signed and then right-clicks and signs the signature field. 

§ Signature content ï Specify the cells-related content to be signed:  

§ Cell value ï The cell values will be signed. 

§ Cell formula ï The cell formula will be signed. 

§ Cell properties ï The following cell properties will be signed: font name, font style 

(indication whether the text is bold or italic), font size, hide row, and hide column. 
 

 
Note: You must set either Cell Values or Cell Formula or both. 
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Default Signature Settings ï Signature Policy 

 

Figure 47  Default Signature Settings ï Signature Policy Tab 

In the Signature Policy tab you can set the following signature default settings: 

§ Clear Policy ï Specify the policy for clearing an existing signature field: 

§ Anyone ï Anyone can clear the signature field. 

§ No One ï No one can clear the signature field. 

§ Signer only ï Only the signer can clear the signature field. 

Imposing Dependency 

You can use the Dependent Signatures option to impose a chronological hierarchy of 

signatures. For example, when you wish to ensure that a document will be signed first by the 

documentôs author, then by the authorôs superior, and then by the regional manager. 

To impose dependency in the digital signature process:  

1. From the Digital Signatures toolbar, click . 

The Default Signature Settings dialog box appears.  

2. In the Settings tab, select Dependent signature type (refer to Default Signature Settings ï 

General Parameters). 



Signing Microsoft Office Documents 5 
 

 61 

All signature fields you place in this document are fields for dependent signatures, and the 

order of the signing dictates the hierarchy of the signatures. For example, in a document 

with four signatures, an attempt to re-sign the first signature will invalidate the second, 

third, and fourth signatures; an attempt to re-sign the second signature will invalidate the 

third and fourth signatures; while an attempt to re-sign the last signature will not 

invalidate any signature. 

3. Position the cursor where you wish the first signer to sign, and click  to insert a 

signature field. 

4. Continue inserting as many signature fields as desired, taking care to place the second 

field where you wish the second signer to sign, the third field where you wish the third 

signer to sign, etc. 

A document with dependent signatures should typically contain text within the document that 

details the correct order of signing, and directs the signers to their respective signature fields.  

Dependency in Excel 

Dependency in Excel is based on the type of signature, as follows: 

§ Signatures based on an active sheet are dependent only on signatures inside the active 

sheet and not in other sheets. 

§ Signatures based on a workspace can be dependent on signatures in other sheets in the 

same workspace. 

§ Dependency cannot be enforced on signatures that are based on a selected area. 

Using Design Mode 

Design mode enables you to change the size, location, and layout of the signature field, as well 

as delete a signature field. 

To use Design mode: 

1. Click  in the toolbar to switch to Design mode. 

2. Perform any of the following, as desired: 

§ Modify the fieldôs location ï Select the signature field and move or resize the field. 
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§ Modify the fieldôs objectôs format: 

§ In Word, you can change the fieldôs size and layout. Right-click the signature field 

and select Format Control from the right-click menu. The Format Control dialog 

box appears. 

 

Figure 48  Wordôs Signature Field Format Control Dialog Box 

Use the Layout tab to specify the layout settings of the signature field. 

Use the Size tab to specify the size settings of the signature field. 
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§ In Excel, you can change the fieldôs colors and lines, size, and properties. Right-

click the signature field and select Format Object from the right-click menu. The 

Format Object dialog box appears.  

 

Figure 49 Excelôs Signature Field Format Object Dialog Box 

Use the Colors and Lines tab to specify the color and line settings of the signature 

field. 

Use the Size tab to specify the size settings of the signature field. 

Use the Properties tab to specify the positioning and printing options of the 

signature field. 

§ Delete the signature field ï Select the field and press Delete on your keyboard. 

3. When you finish modifying the signature field, click  again to toggle out of Design 

mode. 
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Viewing the Signatures List 

In the Digital Signatures dialog box you can view the list of all actual signatures in a 

document. If the signatures are dependent, you can view the dependent signatures of a given 

signature. 

 

Figure 50  Digital Signatures Dialog Box 

To view the list of all signatures: 

§ From the Digital Signatures toolbar, click . 

The Digital Signatures dialog box appears, showing all actual signatures (not signature fields) 

in the document. 

To view dependent signatures:  

§ Right-click a dependent signature and select Dependencies from the right-click menu. 

The Digital Signatures dialog box appears, showing all the signatures on which the specified 

signature depends. 

 
Note: In Excel, signatures that apply to a selected area never depend on other 

signatures. Therefore selecting the Dependencies option for such signature fields 

will show no signatures in the Digital Signatures dialog box. 
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The icon to the left of the signerôs name indicates the signatureôs status, as follows: 

Icon Task 

 
Both the signature and certificate are valid. 

 
A minor problem is detected (for example, the ROOT certificate is not installed 

on this machine and therefore the certificate cannot be validated). 

 
A major problem is detected (for example, the document was tampered with 

after signing). 

To view additional information about the signatures and certificates, refer to Signature 

Details. 

Signature Details 

To view additional information about the signatures and certificates: 

1. Open the Signature Details dialog box in one of the following ways: 

§ Select a signature in the Digital Signatures dialog box and click Details. The 

Signature Details dialog box appears. 

§ Right-click a signature field within the document and select Details from the right-

click menu. The Signature Details dialog box appears. 

 

Figure 51  Signature Details Dialog Box  
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2. To view certificate information, click View Certificate. The Certificate dialog box 

appears. 

 

Figure 52  Certificate Dialog Box  

The Certificate dialog box includes the following tabs: 

§ General ï Provides general certificate information, including the intended use of the 

certificate, to whom the certificate was issued, the certificate issuer, and the 

certificateôs expiration date.  

§ Details ï Provides additional details about the certificate.  

§ Certification Path ï Provides information about the certificates at a higher 

hierarchical level in the chain that approve the current certificate. 

Validating Office Signatures by a User Not Using CoSign 

The following sections describe how a user who is not using CoSign can validate digital 

signatures that were attached using CoSign. 
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Validating Signatures Using the ARX Legacy Word Add-in Plug-in 

If you are not using CoSign, you may still validate signatures that were attached using CoSign. 

This is useful if you receive documents from a company or organization that uses CoSign 

internally. 

To validate signatures: 

1. Obtain the following from a reliable representative of the organization using CoSign: 

§ A copy of ARXôs CoSign Verifier that includes the ARX digital signature plug-in for 

Word and Excel. This copy can be installed using the CoSign Verifier software. 

§ The organizationôs ROOT CA Certificate (.cer  file).  

 
Note: For instructions on how to install the ROOT certificate to a .cer  file, refer 

to Installing the ROOT Certificate for Validation Purposes. 

2. Install the Cosign  Verifier  from the ARX web site or from the organization that has 

an installed CoSign appliance (refer to Installing the CoSign Verifier). 

3. Install the organizationôs ROOT CA Certificate (refer to Installing the ROOT Certificate 

for Validation Purposes). 

Alternatively, install the organizationôs ROOT CA Certificate using the CoSign Verifier 

software. 

 
Note: If an external CA is used, or the CoSign certificate is based on a Worldwide 

verifiable CA, there is no need to install the ROOT certificate. 
 

 
Note: There is no need to install the ROOT CA certificate in a CoSign Desktop 

installation. 

4. Validate the signature (refer to Validating Signatures).  

Validating Signatures in Word Documents Without Using the ARX Legacy Word Add-in 

Plug-in 

If you do not wish to install CoSign nor the ARX Legacy Word Add-in, you can still view the 

signature that was attached using CoSign and validate it, without installing ARX Legacy 

Word Add-in. This is useful if you receive documents from a company or organization that 

uses CoSign internally.  

This operation is applicable for Word XP, Word 2003, Word 2007 and Word 2010, in cases 

where there is a single digital signature inside the document. 
 

 
Note: Although the signature can be viewed, the right-click menu is not available. It is 

available only when the ARX Legacy Word Add-in plug-in is installed. 

To validate a digital signature without using CoSign, refer to Viewing and Validating 

Signatures without Graphical Images in Word and Excel XP/2003. 
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Signing Word and Excel XP/2003 Documents without Graphical 

Signatures  

Word and Excel XP/2003 support digital signatures, enabling seamless integration with 

CoSign. Only the ARX CoSign client  needs to be installed and no additional plug-ins are 

required to digitally sign or validate a signature in a document. For information on installing 

this component, refer to Installing the CoSign Client. 

Signing a Word or Excel XP/2003 Document without a Graphical Signature 

To sign a document in Word or Excel XP/2003 without a graphical signature: 

1. Open the document you wish to sign in its associated application. 

2. Open the Tools menu and select Options. The Options dialog box appears. 

3. Select the Security tab and click Digital Signatures. The Digital Signature dialog box 

appears. 

 

Figure 53  Digital Signature Dialog Box 

4. Click Add. The Select Certificate dialog box appears, listing all your certificates. 

5. Select the desired certificate and click OK. Your signature is appended to the list in the 

Digital Signature dialog box. 

6. Click OK. The document is saved and your signature is attached to the document. 
 

 
Note: You can attach several digital signatures of different users to each Word or 

Excel XP/2003 document. 
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Viewing and Validating Signatures without Graphical Images in Word and 

Excel XP/2003 

To view attached signatures that do not contain graphical images: 

In Word XP/2003: 

1. Open the document in Word XP/2003. 

2. In the status bar at the bottom of the window, double-click . The Digital Signature 

dialog box appears and all the valid certificates are displayed. If this icon is not visible, no 

signatures are attached to the document. 

In Excel and Word XP/2003: 

1. Open the document in Word or Excel XP/2003. 

2. Open the Tools menu and select Options. The Options dialog box appears. 

3. Select the Security tab and click Digital Signatures. The Digital Signature dialog box 

appears and all the valid certificates are displayed. 

 

Figure 54  Digital Signature Dialog Box 

Office XP/2003 also checks whether the certificate exists in a Certificate Revocation List 

(CRL). If the certificate exists in a CRL, you receive a validation error. 
 

 
Note: If the document has been tampered with, you cannot view its certificate. In Excel 

there is no indication at all that the file was ever signed. 
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Note: In Excel XP/2003, the window title of a signed document indicates that the 

document was signed, but the status bar at the bottom of the window does not display the 

validation status of the signature. 

To validate digital signatures in Excel and Word XP/2003: 

1. Obtain the ROOT CA Certificate (.cer  file) from a reliable representative of the 

organization using CoSign. 

2. Install the organizationôs ROOT CA Certificate (refer to Installing the ROOT Certificate 

for Validation Purposes). 

 
Note: If an external CA is used, or if the CoSign certificate is based on a 

Worldwide verifiable CA, there is no need to install the ROOT certificate. 
 

 
Note: There is no need to install the ROOT CA certificate in a CoSign Desktop 

installation. 

3. Click View Certificate to view the certificate information and verify that its CRL and 

certificate chain are correct.  

Signing PowerPoint XP/2003 Documents 

CoSign enables you to add and validate signatures in both PowerPoint XP and 

PowerPoint 2003. 

In PowerPoint XP/2003 documents, perform digital signature operations in the same manner 

as in Word/Excel XP/2003 documents (refer to Signing Word and Excel XP/2003 Documents 

without Graphical Signatures). 
 

 
Note: In PowerPoint XP/2003, the window title of a signed document indicates that the 

document was signed, but the status bar at the bottom of the window does not display the 

validation status of the signature. To validate a digital signature, click View Certificate in 

the Digital Signatures dialog box. 
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Chapter 6: Signing InfoPath 2007/2010 Forms 

CoSign enables generating and validating graphical digital signatures in Microsoft InfoPath 

2007/2010 forms using the InfoPath 2007/2010 built-in support for digital signatures. 

The InfoPath 2007/2010 digital signature mechanism supports multiple and sectional digital 

signatures. The solution is based on placing digital signature fields inside an InfoPath form 

template. This task is usually done by the designer. When a user uses an InfoPath 2007/2010 

form, the user can sign the formôs contents using CoSign. 

This chapter describes how to design digital signature fields in InfoPath 2007/2010 form 

templates and how to sign an Info Path 2007/2010 form. 
 

 
Note: It is assumed that the reader of this chapter has a working knowledge of InfoPath 

forms. 

Note: CoSign versions 5.6 and above do not support earlier versions of InfoPath. 

Note: In this chapter, the term ñCoSign Clientò refers also to the CoSign Desktop, 

unless otherwise stated. 

Note: In this chapter, all screen captures are from InfoPath 2010. 

Understanding Digital Signatures in InfoPath 

Signature Standards in InfoPath 

The main difference regarding signatures between InfoPath 2007 and InfoPath 2010 is that in 

InfoPath 2007, the digital signature is based on the regular XML digital signature standard, 

while in InfoPath 2010 the digital signature is based on advanced XML digital signatures (i.e., 

XAdES). 

Using Graphical Signatures in InfoPath 

You can incorporate visible information such as the userôs graphical signature into the digital 

signature when using InfoPath 2007/2010. However, the available graphical signature is not 

retrieved from the CoSign appliance or the software token/MiniKey, but can be selected only 

from the local disk of the signer. 

If you wish to use a graphical signature stored in CoSign, you can use the CoSign graphical 

signature utility to copy graphical signatures stored in the CoSign appliance or the software 

token/MiniKey to the local disk. You can then incorporate the graphical image from the local 

disk during the InfoPath signing ceremony.  
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Signature Scope and Number of Signers 

A signature field is defined in a specific section of an InfoPath form, but it can apply to any of 

the formôs fields as desired. When the designer creates the signature field, the designer defines 

to which data fields in the form the new signature field applies. This can vary from a single 

data field, to any number of specified data fields, or even all data fields in the form. 

It is also important to note that in InfoPath, a single signature field can include multiple 

signatures from multiple signers.  

This versatility enables varied signing scenarios. The following are some typical scenarios of 

using digital signature in an InfoPath form: 

§ Alice fills in the form, and signs the signature field at the bottom of the form. 

§ Alice fills in the form, and then Alice, Bob and Carol sign the signature field at the bottom 

of the form. 

§ Alice fills in section A and signs it, after which Bob fills in section B and signs it, after 

which Carol fills in section C and signs it. 

Signing InfoPath Forms Using SAPI 

It is also possible to design and prepare digital signature fields using InfoPath 2007/2010 and 

then use SAPI to sign these fields. Validating signatures can also be performed using either 

InfoPath 2007/2010 or SAPI. For more information about SAPI, refer to the CoSign 

Programmer Guide (SAPI). In addition, you can use the ARFileSign utility (described in 

Chapter 9: The ARFileSign Utility) to sign the InfoPath form similarly to using SAPI. 

Typical Work Flow for Using Digital Signatures in InfoPath 

To enable digital signatures in an InfoPath form, the typical work flow is a follows: 

1. Designing the form template ï A designer uses the InfoPath Designer to build an 

InfoPath form template. 

2. Defining signature fields ï To enable integrating digital signatures in an InfoPath form, 

the designer defines one or more signature fields in the form template. Refer to Defining 

Signature Fields in an InfoPath Form Template. Each signature field is placed in a section 

of the form template, and the designer specifies to which data fields the signature applies. 

3. Publishing the template ï The designer publishes the template in an easily accessible 

location so that users can open forms, fill in information, and sign. The designer can either 

publish the form template to a network-based file location or to Microsoft SharePoint 

deployment. 
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4. Filling and signing the InfoPath Form ï A user uses InfoPath filler to open the form, fill 

in information, and sign it. For instructions on signing, refer to Signing a Signature Field 

in an InfoPath Form. 

Note that it is also possible to sign using SAPI (as described in the CoSign Programmer 

Guide (SAPI), or using the ARFileSign utility (as described in Chapter 9: The ARFileSign 

Utility ). In addition, you can use the CoSign add-on for SharePoint solution described in. 

the CoSign for SharePoint User Guide.  

The filled and signed form can be sent via email or managed in the document management 

infrastructure. 

Depending on the type of form and workflow, additional users may need to sign the form, 

or to fill in more information and then sign it.  

In addition, you can: 

§ Validate a signature ï Refer to Validating a Signature in an InfoPath Form. 

Alternatively, you can use SAPI to verify the signature. 

§ View signature details ï Refer to Viewing Signature Details in an InfoPath Form. 

§ Remove a signature ï Refer to Removing a Signature from an InfoPath Form. 

Prerequisites for Signing an InfoPath Form 

CoSign enables you to add graphical signatures to InfoPath forms in Office 2007/2010. To 

enable graphical and digital signatures, you must install the ARX CoSign Client  

component. For information on installing CoSign client, refer to Installing the CoSign Client. 
 

Note:  Because ARXôs solution for InfoPath does not require any plug-in installation, you can 

install Office 2007/2010 after the CoSign components are already installed. 

Defining Signature Fields in an InfoPath Form Template 

After designing a template for an InfoPath form (such as the form in Figure 55), the designer 

can add signature fields to the template. A signature field is added in a specific section of the 

form, but it can apply to any of the formôs fields as desired. In other words, when you create 

the signature field, you define to which data fields in the form the new signature field applies. 

This can vary from a single data field, to any number of specified data fields, or even all data 

fields in the form. 
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Figure 55  Sample InfoPath Form  

To add a digital signature field to a section in an InfoPath form template: 

1. Right-click a section and select Section Properties. 

2. Select the Digital Signatures tab.  
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Figure 56  Digital Signatures Tab  

3. Check the Allow users to digitally sign this section check box. 
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Figure 57  Digital Signatures Tab ï Allow users to digitally sign this section 

4. In the drop-down list, select Add data that can be signed. 

The Set of Signable Data window appears. 
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Figure 58  Set of Signable Data Window 

5. In Type a nameé, enter a name for the signature field.  

6. In Fields and groups to be signed, click  to select the data fields to which this 

signature field applies. Data fields are arranged hierarchically, so keep in mind that 

selecting a node selects all its sub-nodes. 

7. In Signature options, select one of the following: 

§ Allow only one signature ï Only a single signature is allowed in this signature field. 

§ All the signatures are independent (co-sign) ï The signature field supports multiple 

signatures, which are independent of each other. In other words, the order in which 

the signers have signed has no significance. The practical implication of this is that a 

signer can re-sign by deleting his/her previous signature, and signing again. 

§ Each signature signs the preceding signature (counter-sign) ï The signature field 

supports multiple signatures, but a signer cannot go back and re-sign if someone else 

has meanwhile signed. The practical implication of this is that a signature cannot be 

deleted if another signature has subsequently been added to the signature field.  

8. In the Signature confirmation message box, you can define the message that will appear 

when the signer activates the signature ceremony. 

9. Click OK. 

A digital signature field is attached to the section.  
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The next step is to publish the template so that users can fill in forms and sign them. You can 

either publish the form template to a network-based file location or to Microsoft SharePoint 

deployment. 

Signing a Signature Field in an InfoPath Form 

 
Note: You can incorporate a graphical signature into your digital signature, provided the 

graphical signature is on the local disk. Therefore, if you wish to incorporate a graphical 

signature you stored in the CoSign appliance or the software token/MiniKey, first transfer 

it to the local disk. To do so, use the Download Images option in the Graphical Signature 

Management Application (Figure 17). 

In forms that require signatures, the user typically signs a section after entering information 

into the data fields of the section. 

To sign a signature field: 

1. Locate the relevant signature field indication. This is the Click here to sign this section 

link, usually located in the section you are filling in or at the bottom of the form 

(Figure 59). 

 

Figure 59  Signature Field Indication 

If you are signing a signature field that allows multiple signatures, it may already contain 

several signatures. In that case, the signature field looks similar to the one shown in 

Figure 60. 
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Figure 60  Signature Field Indication with Multiple Signatures 

2. Press Click here to sign this section. A Sign window appears. 
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Figure 61  Sign Window ï Before Entering Signature 

3. To sign, you can either enter your name or select a graphical image (not both). Therefore, 

in the box adjacent to the X perform one of the following: 

§ Enter your name. 

§ Click select imageéto select your graphical signature from the local hard disk.  

4. Optionally, enter the reason for signing in the Purpose for signing this document field. 

 
Note: If you have more than one certificate, you can click Change to select the desired 

certificate. 
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The filled-in signature form will look similar to the following example: 

 

Figure 62  Sign Window ï After Entering Signature 

5. Click Sign. 

The data fields to which this signature apply are signed by CoSign or CoSign Desktop. 

They are now locked, as indicated by the seal appearing in the fields. 

 

Figure 63  Signed and Locked Data Field  

The relevant signature section in the form looks similar to the following: 
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Figure 64  Signed Section 

Keep in mind that if the signature field allows multiple signatures, additional digital 

signatures may be appended to the field. 

The document can be sent via email or managed in the document management infrastructure. 

 
Note: You can also digitally sign an InfoPath form using invisible signatures. For more 

information, contact ARX. 

Validating a Signature in an InfoPath Form 

Digital signatures in an InfoPath form can be validated. 

To validate a signature: 

1. Double-click the signature in the form.  

The Signature Details window appears. 

§ If the signature is valid, a window similar to the following is displayed: 
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Figure 65  Signature Details ï Valid Signature  

The upper part of the window displays the status of the digital signature (such as the 

type of advanced signature). Signature type is relevant only if you sign using 

InfoPath 2010 or using CoSign tools such as SAPI or the CoSign add-on for 

SharePoint. 

§ If the content of a data field to which the signature applies was changed after signing, 

a window similar to the following is displayed: 

 

Figure 66  Signature Details ï Unverified Signature 
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Viewing Signature Details in an InfoPath Form 

You can view signature details of digital signatures in an InfoPath form. 

To view information about a signature in an InfoPath form: 

1. In the Info section of the File tab, click Digital Signatures. 

 

Figure 67  InfoPath Digital Signature Button 

The Digital Signatures window appears. 

 

Figure 68  Digital Signatures Window 

2. View the information displayed in the signers list. The list displays pertinent signature 

details.  

3. Optionally, view a signerôs certificate: select a signature, and click View Certificate. A 

window appears (similar to Figure 52), displaying certificate information for this 

signature. 

4. Optionally, view additional signature information: select a signature, and click View 

signature. The Signature Details window appears (Figure 65), displaying various 

signature details. 
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In addition, from the Digital Signatures window you can also: 

§ Add a signature. To do so: 

a. Click Add. A list of all defined signature fields is displayed.  

b. Select a desired signature field. The Sign window appears (Figure 61).  

c. Perform the instructions following Figure 61.  

§ Delete a selected signature. For more information, refer to Removing a Signature from an 

InfoPath Form. 

Removing a Signature from an InfoPath Form 

You can delete a signature from an InfoPath form. 

To delete a signature from an InfoPath form: 

1. In the Info section of the File tab, click Digital Signatures (Figure 67). 

The Digital Signatures window appears (Figure 68). 

2. Select the signature you wish to delete, and click Remove.  

 
Note: You can only delete the most recent signature in a signature field that 

was defined as a multiple counter-sign signature field. All previous signatures 

in the counter-sign signature field cannot be deleted.  

3. Confirm the operation. 
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Chapter 7: Signing Adobe Acrobat Documents 

The CoSign client enables you to digitally sign Adobe Acrobat documents using both Adobe 

Acrobat and Adobe Reader, as well as add your graphical signature to the PDF file. This 

enables you to: 

§ Easily sign an Acrobat document ï The Acrobat document may contain multiple 

signatures, and each signature can be located in a different part of the document. It is also 

possible to generate several signatures for the same end-user. If a document is modified, 

the end-user is notified that the document was modified and is able to view the specific 

version of the document that was signed. 

§ Certify an Acrobat document ï Certification is more stringent than the regular signature 

operation. When a document is certified, it can be defined that no modification can be 

applied to the document (not even the addition of a new version to the document), or it can 

be defined that only certain fields in the document can be updated.  

Certification is available in Acrobat 6/7/8/9/10.  

§ Validate the signature of an Acrobat document ï Validation assures you that the 

document version that was signed was not modified after it was signed and that a trusted 

CA approves the user who performed the signature operation. 

The solution for Adobe 6/7/8/9/10 also does not require a client installation on the validatorôs 

side. 

As part of the CoSign Web Services solution, the CoSign appliance provides a new Web 

Service mechanism called Adobe Roaming ID. This mechanism enables Adobe Acrobat 8/9/10 

or Adobe Reader 8/9/10 to directly interface the CoSign appliance for digital signature 

operations, without requiring the installation of a CoSign client in the end userôs PC. This 

chapter provides instructions on how to setup Adobe Acrobat 8 and Adobe Reader 8 to 

directly use the CoSign appliance for digital signature operations.  
 

Note: Adobe Acrobat includes sophisticated mechanisms for handling digital signatures. 

These mechanisms enable you to maintain different versions of the Acrobat document, so that 

each digital signature actually signs a different version of the document. Be aware that even if 

the document is modified, older digital signatures will be validated against an older version of 

the document. 
 

Note: CoSign is currently compatible with versions 6.x, 7.x, 8.x, 9.x and 10.x of Adobe 

Acrobat, and versions 6.x, 7.x, 8.x, 9.x and 10.x of Adobe Reader. Refer to the Adobe 

documentation for complete information on Adobeôs digital signature capabilities. 

This chapter describes signing and validating an Acrobat Document using Adobe 

Acrobat 6/7/8/9/10, as well as signing and validating signatures using Adobe Reader 

6/7/8/9/10. 

 
Note: In this chapter the term ñCoSign Clientò refers also to the CoSign Desktop, unless 

otherwise stated. 
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Signing an Acrobat Document using Adobe Acrobat 6/7/8/9/10 

 

Note:  CoSign supports Adobe 6, Adobe 7, Adobe 8, Adobe 9 and Adobe 10, but the dialog 

boxes shown in this chapter are Adobe 8 dialog boxes. They may differ slightly from the other 

versionsô corresponding dialog boxes. 

Using Adobe Acrobat 6/7/8/9/10, you can generate and validate digital signatures. The 

following sections describe how to use the Acrobat 6 Windows Certificate Security and 

Acrobat 7/8/9/10 Adobe Default Security signature handlers to set up, sign, and validate digital 

signatures, as well as certify Acrobat documents. They also describe how to sign and validate 

signatures using Adobe Reader 6/7/8/9/10. 

For each signature request, CoSign is activated for the purpose of signature operation only. 

Setting up Adobe Acrobat 6/7/8/9/10 to Use Digital Signatures  
 

Note: This setup procedure only needs to be performed once per workstation. 

To setup Acrobat to use digital signatures: 

1. Make sure a graphical signature is stored in the local CoSign workstation. 

2. Make sure the Adobe Acrobat application is closed. 

3. Refer to Managing Graphical Signatures for instructions on how to import the CoSign 

based graphical signatures into the local Adobe installation in the end userôs PC. 

4. In Acrobat, select Edit Ą Preferences. The Acrobat Preferences dialog box appears. 
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Figure 69  Acrobat 8 Preferences Dialog Box 

5. Select the Security option. The ARX Signature -<signature name> appearance appears 

selected in the Appearance box. 

6. Click Advanced Preferences. The Digital Signatures Advanced Preferences dialog box 

appears with the Windows Integration tab selected. 
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Figure 70  Adobe Reader Advanced Preferences Dialog Box 

7. Select all the options in the Microsoft Windows Integration tab. 

8. Click OK to return to the Preferences dialog box. 

Using the Edit button, you can edit the appearance of the digital signature (refer to Editing the 

Signatureôs Appearance). 
 

Note: Setting the Verify signatures when document is opened option automatically 

activates a validation procedure for all of the documentôs digital signatures when the 

document is opened. The default is that digital signatures are not validated automatically 

when a document is opened. 

Editing the Signatureôs Appearance 

You can configure the visual look of the digital signature by specifying the information to be 

presented in the digital signature location in the Adobe document. 

To edit the appearance of the signature: 

1. In the Preferences dialog box (Figure 69), select the relevant ARX Digital Signature 

appearance. 

2. Click Edit. The Configure Signature Appearance dialog box appears. 
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Figure 71  Adobe 8 Configure Signature Appearance Dialog Box 

3. In the Configure Graphic section, specify one of the following:  

§ No graphic ï No graphic will be displayed. 

§ Imported graphic ï The userôs graphic signature will be displayed with the signature.  

Avoid using the PDF file button for specifying which file to load, since the Update 

Acrobat option in the CoSign control panel loads the userôs graphic signature. 

§ Name ï Only the name of the signer will be displayed. 

4. In the Configure Text section, specify which text elements to include in the signature. 

If  you specify the Logo option, a Logo will be displayed as part of the visible signature. 

When the Update Acrobat option is activated on a Logo image, the default Logo of the 

Adobe Reader/Acrobat is updated. 

5. Click OK to return to the Preferences dialog box. 

Signing an Adobe Acrobat Document ï Acrobat 6/7/8/9/10 

To digitally sign an Acrobat document using Acrobat 6/7/8/9/10: 

1. In Acrobat, open the document you wish to sign. 
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2. Click  and select Place Signature, or select Advance Ą Sign&Certify Ą Place 

Signature. 

3. A pop-up message will appear, instructing you to specify the location of the signature. 

Click and drag the cursor to create a rectangle on the screen where you want the signature 

to be located. 

The Sign Document dialog box appears. 

 

Figure 72  Acrobat 8 Sign Document Dialog Box 

4. Select your Digital ID (certificate) and the desired Appearance to be used, and click Sign. 

The digital signature is created. The signature may be visually presented as follows: 

 

Figure 73  Acrobat 8 Digital Signature Example 
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To configure this process to enable you to provide a reason for the signature during the 

signature operation: 

1. Make sure that the Appearance is configured to display a Reason. 

2. Set the value of Show Reasons When Signing to On in the Digital Signatures Advanced 

Preferences / Creation tab. 

In this case, the Sign Document dialog box appears as follows: 

 

Figure 74  Acrobat 8 Sign Document Dialog Box ï with Reason 

The digital signature appears as follows: 

 

Figure 75  Acrobat 8 Digital Signature Example ï with Reason 
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Modifying a Signed Acrobat Document 

If you modify a signed document, all existing digital signatures are marked with a , to 

indicate that the signature is valid, but the document has been updated since it was signed. The 

digital signature matches an old version of the document that can be displayed. Following 

validation, the icon  indicating that the document was modified is displayed in the 

Signatures palette.  

Saving the document will mark all existing signatures with , to indicate that the digital 

signature needs to be validated when the document is opened. 

You can analyze the differences between the current document and the signed document using 

the Compare Signed Version to Current Document option (refer to Operations on 

Signatures in Adobe Acrobat 6/7/8/9/10 Documents). 

Operations on Signatures in Adobe Acrobat 6/7/8/9/10 Documents 

There are two ways to view and validate digital signatures: 

§ In the location of the digital signature there is a validation image, which can be one of the 

following images:  

§  ï Signature is validated. 

§  ï Signature needs to be validated. 

§  ï Signature is not validated. 

§ ï Signerôs identity is unknown. 
 

Note: The image  can be combined with other images to indicate that the document has 

been updated since it was signed. 

§ Using the Signatures palette on the left side of the Acrobat window (Figure 76). The 

window displays the existing digital signatures associated with the Acrobat document. 

Information is listed for each signature, including the name of the signer, signature date, 

and document revision. 
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Figure 76  Acrobat 8 Signature Palette 

The following digital-signature operations can be performed by right-clicking either the image 

of the digital signature or the digital-signature entry in the Signatures palette. 

§ Clear Signature ï Clears the digital signature but keeps the digital-signature field. This 

enables you to sign the document again and put the new digital signature in the original 

field. 

§ Validate Signature ï Performs a validation of the digital signature against the document 

information. A dialog box appears, displaying the results of the signature validation. 

 

Figure 77  Acrobat 8 Signature Validation Status 
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§ View Signed Version ï If the document was modified after the digital signature was 

added,  will be added to the original signature image. The View Signed Version option 

enables you to view the actual document that was signed. 

§ Compare Signed Version to Current Document ï Displays the differences between the 

current document and the version of the document that was signed using this digital 

signature.  

§ Properties ï Displays detailed information about the signature, including validity of the 

signature, Signer ID, Signature date, and other details. 

Also, the certificate details of the signer can be viewed by clicking Show Certificate. 

§ Go To Signature Field ï Enables you to locate a digital signature in the Acrobat 

document. This option is available only from the Signatures panel. 

If the Signature field is not Sign, the following option is available: 

§ Sign Document ï The digital signature will be created in the Signature field. The Sign 

Document dialog box will be presented as described above. 

Access the following options by clicking Options at the top of the Signatures palette: 

§ Validate All Signatures ï Checks all the signatures in the document and validates them. 

§ Clear all signature fields ï Removes all digital signatures from the document and leaves 

only digital signature place holders.  
 

Note: By clicking a digital signature image, a validation action is executed. After a successful 

validation, ã is displayed. 

Certifying an Adobe Acrobat Document ï Acrobat 6/7/8/9/10 

In Adobe 6/7/8/9/10 you can perform an operation called Document Certification, which is 

ñstrongerò than the regular signature operation: when a document is certified, you can specify 

one of the following certification modes: 

§ No further changes allowed ï No changes are permitted to the PDF document. 

§ Form filling & signing allowed ï You may enter data in forms, and sign existing 

signature fields in the PDF document. 

§ Annotations, form filling & signing allowed ï You may add annotations to the 

document, enter data in forms, and sign existing signature fields in the PDF document. 

During certification, the document is signed with your Private Key and Certificate. 

To certify a document: 

1. In Acrobat, open the document you wish to sign. 

2. Click  and then Certify with Visible Signature or select Advance Ą 

Sign&Certify Ą Certify with Visible Signature or Advance Ą Sign&Certify Ą Certify 

without Visible Signature. 
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3. The signature operation is very similar to the regular digital signature operation (the 

Certify Document dialog box appears). The major difference from the regular digital 

signature is that you can specify what type of content can be modified after the 

certification operation. 

 

Figure 78  Acrobat 8 Certify Document Dialog Box 

The digital signature appears as follows (if a visible signature is required). 
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Figure 79  Acrobat 8 Certification Image Example 

 

Note: Only a file that is not signed can be certified, which means that a file that contains 

digital signatures cannot be certified. 

Using the Update Acrobat Option in the Graphical Signatures Utility 

This option creates a new appearance called ARX Signature - <graphical signature name> 

into which it imports the userôs graphical digital signature. This enables Adobe Acrobat or 

Adobe Reader to incorporate CoSign graphical signatures in the Adobe graphical signature 

when a digital signature operation is activated. 

The utility is activated by first activating the Graphical Signature Management application, 

then selecting the name of the graphical signature you wish to use in Acrobat, and then 

clicking Update Acrobat (refer to Managing Graphical Signatures).  

This option is enabled only if the Graphical Signature Management application utility is 

working in user mode, in which the user can create his/her own graphical signature. 

To edit the various settings of the ARX Digital Signature appearance, refer to Editing the 

Signatureôs Appearance. 
 

Note: It is recommended to activate this option when Adobe applications are not running, to 

prevent file-sharing problems. 

Validating CoSign Signatures Using Adobe Reader 6/7/8/9/10 

Adobe Reader enables you to view and validate digital signatures in the document. 

No plug-in is necessary for the proper validation of an Adobe 6/7/8/9/10 document. 

To setup Adobe Reader 6/7/8/9/10 to validate signatures, perform the following once: 

1. Install the organizationôs Root CA Certificate. Refer to Installing the ROOT Certificate 

for Validation Purposes. 

This operation is not required if you have a World Wide Verifiable certificate.  

2. Click Advanced Preferences and then click the Windows Integration tab. 
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Figure 80  Acrobat 8 Advanced Preferences Dialog Box 

3. Select all the options in the dialog box. 

4. Click OK to return to the Preferences dialog box. 

5. Click OK to exit the Preferences dialog box. 

 
Note: the CoSign Verifier sets the Adobe parameters as shown in Figure 80. Note that 

there is an Adobe-only version of the CoSign Verifier that only sets these Adobe 

parameters. 

The digital signatures appear inside the Acrobat document next to the validation symbol. If the 

digital signature contains a graphical signature, the graphical signature is displayed as well. 

When a document containing digital signatures is opened, a question mark is displayed next to 

each signature. After you validate the signature, the question mark symbol changes to a 

validated mark.  

The following digital-signature operations can be performed by right-clicking either the image 

of the digital signature or the digital-signature entry in the Signatures palette. 

§ Validate Signature ï Performs a validation of the digital signature against the document 

information. 

§ View Signed Version ï Enables the user to view the exact version of the document that 

was signed. 

§ View Signature Properties ï Displays detailed information about the signature, including 

validity of the signature, signature date, user ID, signature creation date, certificate 

expiration, certificate issuer, and certificate details. 
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§ Go to Signature Field ï Enables you to locate a digital signature in the Acrobat 

Document. This option can only be activated from the Signatures panel. 

§ Validate all Signatures ï Checks all the signatures in the document and validates them. 

This option can be viewed only from the Options button at the top of the Signatures 

palette. 

Note: Adobe Reader can be configured to automatically validate digital signatures on 

opening a document by setting the Verify signatures when document is opened option. 

Refer to Setting up Adobe Acrobat 6/7/8/9/10 to Use Digital Signatures. 

Signing an Acrobat Document Using Adobe Reader 6/7/8/9/10 

You can also perform signature operations using Adobe Reader version 6/7/8/9. However, you 

need to use specially formatted Acrobat files that already contain signature fields. Once you 

locate a signature field in the document, you can perform the digital-signature action.  

Once you select the digital signature box, the signing process is similar to the signing process 

using Adobe Acrobat (refer to Signing an Adobe Acrobat Document ï Acrobat 6/7/8/9/10). 

 
Note: You cannot perform the Certify operation using Adobe Reader. 

Signing a PDF document Without Using Adobe Acrobat 

To sign PDF files without installing Adobe Acrobat, you can use OmniSign (refer to 

Chapter 8: OmniSign ï Signing PDF and non-PDF Files). 

Signing in Adobe Acrobat/Reader 8/9/10 Using Adobe Roaming ID 

In Adobe Reader 8/9/10 and Adobe Acrobat 8/9/10, Adobe can be set to use a different digital 

signature mechanism called roaming ID that is based on Web Services. This mechanism 

enables you to digitally sign PDF documents without installing any software in the client PC. 

This means that this option is not in the scope of CoSign Client or the CoSign Desktop and is 

relevant only when configuring Adobe Acrobat or Adobe Reader to use the CoSign appliance. 

Adobe Reader and Adobe Acrobat can interface the CoSign appliance through a Web Service 

interface. The roaming ID mechanism requires a user to authenticate to the CoSign appliance 

based on a user name and password and perform a digital signature operation using the userôs 

signature key inside the CoSign appliance. 

You can use roaming ID in any of the following modes: 

¶ User generates a roaming ID profile ï In this mode, the PDF document contains a 

signature field that does not include a roaming ID profile. You must define a roaming ID 

profile in advance, and use it during the digital signature operation. Refer to Generating a 

Roaming ID Profile. 
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¶ Signature field already contains a URL ï In this mode, the PDF document contains a 

signature field which already includes the URL of the CoSign appliance that will enable 

the end user to invoke the digital signature Web Service in Adobe. In this mode, the end 

user needs only to perform a digital signature operation. Refer to Signing a Signature 

Field that Contains a URL. 

Generating a Roaming ID Profile 

To define a roaming ID profile: 

1. In Adobe Reader, select Document > Security Settings. The Security Settings dialog box 

appears. 

 

Figure 81  Security Setting Dialog Box 

2. Select Roaming ID Accounts in the left pane of the Security Settings dialog box. 

3. Click Add Account. The Add a Roaming ID dialog box appears. 
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Figure 82  Add a Roaming ID Dialog Box ï Entering a Name and URL 

4. Enter the following information: 

§ Name ï Enter a name such as CoSign . 

§ URL ï Enter a value such as https://cosign:8080/SAPIWS/assp.asmx . 
 

Note:  By default, the CoSign appliance is distributed with a temporary SSL certificate called 

cosign. You can generate your own SSL Server Certificate and name it with CoSignôs DNS 

name; for example, cosign.company.com). 

If you would like use the CoSign temporary certificate, define an entry named cosign in your 

local hosts file, and specify the IP address of the CoSign appliance. The local hosts file is 

located in /etc/hosts  in UNIX platforms, and in 

Windows \ System32 \ drivers \ etc \ hosts  in Windows platforms. 
 

Note: If you enroll for an SSL Server certificate, refer to the Managing the CoSign Appliance 

chapter in the CoSign Administrator Guide for instructions on how to upload the SSL Server 

certificate to the CoSign appliance. 

5. Click Next. In the window that appears, enter a user ID and a password for authenticating 

to the CoSign appliance. 
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Figure 83  Add a Roaming ID Dialog Box ï Entering a User Name and Password 

6. Click Next. The final window appears, displaying the roaming ID settings, including the 

date when the Userôs certificate expires. 
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Figure 84  Add a Roaming ID Dialog Box ï Displaying Roaming ID Information 

7. Click Finish.  

The selected certificate will be listed in any subsequent digital signature operation. If you 

choose this certificate, Adobe Reader/Adobe Acrobat will access the CoSign appliance for the 

digital signature operations. During this attempt, the user will be requested to supply a User ID 

and a password. The signature field that appears when using a roaming ID is identical to a 

regular signature field. 
 

Note: The Roaming ID mechanism does not automatically support a graphical signature. To 

use a graphical signature, you must manually insert a graphical signature in Adobe 

Reader/Adobe Acrobat using the Appearance mechanism. 
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Signing a Signature Field that Contains a URL 

If the user initiates a digital signature operation and the signature field already contains a URL 

for accessing the CoSign appliance, the user is requested to enter a User name and a password 

for accessing the CoSign appliance. This act will generate a roaming ID profile for the user, 

which the user can use for all subsequent signing operations.  

To sign a signature field that includes a URL: 

1. When you initiate a digital signature operation and the signature field already contains a 

roaming ID profile, the following window appears. 

 

Figure 85  Sign Document Dialog Box ï Displaying Roaming ID Information 

2. Select the username from the Digital ID drop-down list. 

3. Select the appearance of the signature in the Appearance drop-down list. If you select an 

appearance that contains a graphical signature, this graphical signature will be included in 

the digital signature.  

4. Click Sign. A dialog box appears, requesting a password. 

5. Enter the password corresponding to the username you selected. 

Validating the digital signature is similar to validating a regular digital signature. Refer to 

Validating CoSign Signatures Using Adobe Reader 6/7/8/9/10 for more information. 
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Chapter 8: OmniSign ï Signing PDF and non-PDF Files 

This chapter describes how to use OmniSign to manage all digital signature related operations 

in a PDF document, and sign any printable data from any application. 

 
Note: In this chapter the term ñCoSign Clientò refers also to the CoSign Desktop, unless 

otherwise stated. 

Overview of OmniSign 

The major benefits offered by OmniSign include: 

§ Easily sign existing PDF documents. 

§ Sign non-PDF documents by using the documentôs application File > Print command. 

While CoSign comes with extensive third party application support for digital signatures, 

there are other applications that do not provide digital signature support such as ERP 

systems, homegrown systems, and others.  

With OmniSign, any of these applications that support standard printing functionality can 

utilize OmniSign to add digital signatures to their documents. 

§ Manage all digital signature related operations in a PDF document. 

Launching OmniSign 

There are several ways to launch OmniSign. 

Launching OmniSign with a PDF file 

If your file is in PDF format, you can launch OmniSign in any of the following ways:  

§ Right-click the file name and select Sign with CoSign. OmniSign is launched for the PDF 

file. 

 
Note:  If the Sign with CoSign option does not exist in the right-click menu, 

you can add it as follows: Launch OmniSign via the CoSign Control Panel, and 

in the OmniSign application select Tools Ą Add ôSign with CoSignô to PDF 

files. 

§ Select Start Ą ARX CoSign Ą OmniSign. OmniSign is launched. Open a file by 

selecting File > Open in the OmniSign menu bar and browsing to the file. 

§ Select OmniSign in the CoSign Control Panel. OmniSign is launched. Open a file by 

selecting File > Open in the OmniSign menu bar and browsing to the file. 

§ Drag the PDF file onto the OmniSign icon or shortcut. 
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Launching OmniSign with a Remote PDF File Using the WebDAV Protocol 

Starting from CoSign version 5, you can use OmniSign to open a PDF remotely by providing 

the URL of the PDF file.  

To open a remote PDF file: 

1. Select OmniSign in the CoSign Control Panel. OmniSign is launched.  

2. Select File > Open and enter the URL of the remote PDF file. For example: 

http://www.organization.com/documents/mypdf.pdf. 

OmniSign uses the Web-based Distributed Authoring and Versioning (WebDAV) protocol 

to download the PDF file from a remote web server, perform the digital signature, and 

upload the file to its designated location. 

After downloading the file, you can use OmniSign to perform all available operations on the 

PDF file, such as adding digital signatures, adding digital signature fields, etc. The File Ą 

Save operation saves the PDF to its remote location. 

You can also use the HTTPS protocol for accessing the remote file in a secured manner. In 

this case, it is mandatory that the HTTPS server site be trusted by the connecting client. 

In addition, you can configure OmniSign so that it can be launched from the right-click menu 

of a link to a PDF file (if the link is in an HTML document displayed in Internet Explorer).  

To enable OmniSign to be launched from the right-click menu of a link to a PDF file:  

1. Select OmniSign in the CoSign Control Panel. OmniSign is launched.  

2. Select Tools > Show in Internet Explorer Popup Menu.  

The result is that in any HTML document in Internet Explorer, if you right-click a 

hyperlink to a PDF file and select Sign with CoSign, OmniSign uses WebDAV to 

download the PDF file from a remote web server, perform the digital signature, and 

upload the file to its designated location. 

Launching OmniSign with a non-PDF file 

If your file is in non-PDF format, you can easily convert it to PDF using OmniSign, and at the 

same time launch the OmniSign application. 

To launch OmniSign with a non-PDF file: 

1. Open the file in its application. 

2. Select File > Print. The Print dialog box appears. Figure 86 displays the standard Print 

dialog box that appears in Word. 

3. Select ARX CoSign OmniSign Printer as the printer. 
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Figure 86  Selecting the ARX CoSign OmniSign Printer 

4. Change the print properties if desired. 

5. Click Print. 

Clicking Print triggers the PDF conversion process, during which a temporary file is created 

in the Windows Temp folder with the file name derived from the printing job name. The file 

content is then converted to PDF format and the OmniSign application is launched for the 

newly created PDF file.  

 
Note: When you drag a non-PDF file onto the OmniSign icon or shortcut, the Print 

option of the associated application is triggered using the OmniSign printer, and the 

OmniSign application is opened displaying the generated PDF file. 
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Getting Started with OmniSign 

Figure 87 shows a sample OmniSign window. 

 

Figure 87  OmniSign Window 

The OmniSign window includes the following elements: 

§ Menu bar ï Enables you to perform various signature related operations such as creating 

and signing a new signature field in the PDF document, adding a new electronic signature 

into the document, and validating all existing digital signatures in the document. 

§ Toolbar ï The toolbar includes some of the operations that can be performed using the 

OmniSign menu bar. 

 

Figure 88  OmniSign Toolbar 

The two drop-down lists contain options for creating a signature field and for signing a 

signature field. The last operation you select from a drop-down list is the default 

operation. 
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§ Navigation bar ï The Navigation bar enables you to navigate to a certain page in the 

current document, and control the zoom level of the currently viewed page in the main 

OmniSign window. 

§ Main window ï Displays the currently open PDF document or documents. You can 

display documents in the OmniSign main window in either of two ways:  

§ Static mode ï The current PDF document is displayed in the main window, enabling 

you to perform various signature related operations. 

§ Cascading mode ï All opened PDF documents are cascaded in the main window. 

Double-click the title bar of a PDF document to maximize it. 

To switch from Cascading mode to Static mode, double-click the title bar of a PDF 

document. To switch from Static mode to Cascading mode, select Restore in the  menu 

of the menu bar. 

You can also set whether to display the PDF document one page at a time, or whether to 

display the whole PDF document so you can scroll through the whole document. Select 

View Ą Navigation Type to switch between the two options. 

§ Signatures panel ï Enables you to view all signed and non-signed signature fields, and 

perform various operations on the signature fields.  

Inserting a Digital Signature Field 

You may wish to insert a digital signature field without signing it, for example if you are 

designing a document template.  

To create a digital signature field:  

1. Click   in the toolbar, or select Signatures Ą Add Digital Signature 

Field. 

2. In the main window, drag the mouse to the desired location of the new signature field. 

Left-click once to specify one corner of the field. Continue dragging the mouse until the 

desired size is displayed, and release the mouse to specify the opposite corner. A new 

signature field is created (Figure 89). 
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Figure 89  New Signature Field 

3. Drag any of the handles in the corners of the fieldôs rectangle to change the shape of the 

signature field. You can also drag the entire signature field to a different location by 

clicking inside the rectangle and dragging it. 

4. Optionally, specify signature settings for this signature. To do so, right-click inside the 

signature field and select Settings, or select Settings from the Options drop down menu 

appearing just above the signature field.  

 

Figure 90  New Signature Options 

The Signature Settings window appears (refer to Configuring Default Signature Settings 

for a Single Signature). Edit the settings as desired.  

Signing an Empty Digital Signature Field 

To sign an empty existing digital signature field:  

1. Locate the empty digital signature field. 

2. Select Sign from the Options drop down menu appearing just above the signature field 

(Figure 90). 

3. The standard Signing Ceremony dialog box appears (Figure 30). Select or enter the 

relevant information. 

4. Click Sign. A digital signature operation is performed.  
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Creating and Signing a Digital Signature Field 

You can create a digital signature field and sign it in a single operation. 

 
Note:  If you wish to view or change any OmniSign settings before signing, refer to 

Configuring Default Signature Settings. 

To create and sign a digital signature field:  

1. Click  in the toolbar, or select Signatures Ą Sign. 

2. In the main window, click the mouse to the desired location of the new signature field. 

Left-click once to specify one corner of the field. Drag the mouse until the desired size is 

displayed, and release the mouse to specify the opposite corner. 

The standard Signing Ceremony dialog box appears (Figure 30).  

3. Select or enter the relevant information for the digital signature act. For more information 

about the standard signature ceremony dialog box, refer to the explanations following 

Figure 30.  

4. Click Sign. The created signature field is digitally signed. 

 
Note: When the digital signature is being validated using Adobe Acrobat 6/7/8/9/10 or 

Acrobat Reader 6/7/8/9/10, a message appears to inform you that the time stamp of the 

digital signature is taken from the local computer, even though the actual time is taken 

from the CoSign appliance. 

To provide a more secure time source, you can add a time stamp to every digital 

signature using the CoSign Configuration utility (refer to Signature API ï Time Stamp). 

Inserting an Electronic Signature Field 

You can incorporate an electronic signature into the PDF document. An electronic signature is 

a graphical image of an end-userôs handwritten signature. This method is very suitable for a 

Point Of Sale purchase. In a Point Of Sale purchase type of usage, after the purchase form is 

completed, the customer inserts his/her electronic signature, and the local sales person 

digitally signs the whole document. 

To insert an electronic signature field:  

1. Click  in the toolbar, or select Signatures Ą Add Electronic Signature 

Field. 

2. In the main window, drag the mouse to the desired location of the new signature field. 

Left-click once to specify one corner of the field. Continue dragging the mouse until the 

desired size is displayed, and release the mouse to specify the opposite corner. A new 

signature field is created (Figure 89). 
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3. Drag any of the handles in the corners of the fieldôs rectangle to change the shape of the 

signature field. You can also drag the entire signature field to a different location by 

dragging the whole rectangle. 

4. Optionally specify signature settings for this signature. To do so, right-click inside the 

signature field and select Settings, or select Settings from the Options drop down menu 

appearing just above the signature field (Figure 90). 

The Signature Settings window appears (refer to Configuring Default Signature Settings 

for a Single Signature). Edit the settings as desired.  

Signing an Electronic Signature Field 

To sign an existing electronic signature field:  

1. Locate the empty electronic signature field. 

2. Select Sign from the Options drop down menu appearing just above the signature field 

(Figure 90). The standard signing ceremony box appears (Figure 30). 

3. Select or enter the relevant information. Note that because this is an electronic signature 

field, you will not be able to select a certificate. 

4. Click Sign. An electronic signature operation is performed. Because there is no definition 

of an electronic signature in PDF, the electronic signature will turn into a graphical image 

that is embedded into the PDF document. 

 Note:  It is not possible to clear an electronic signature or remove an electronic signature 

field. 

Creating and Signing an Electronic Signature Field 

You can create an electronic signature field and sign it in a single operation. 

To create and sign an electronic signature field: 

1. Click  in the toolbar, or select Signatures Ą Sign an Electronic Signature. 

2. In the main window, drag the mouse to the desired location of the new signature field. 

Left-click once to specify one corner of the field. Continue dragging the mouse until the 

desired size is displayed, and release the mouse to specify the opposite corner. 

The standard Signing Ceremony dialog box appears (Figure 30). 

3. Select or enter the relevant information for the electronic signature act. For more 

information about the standard Signing Ceremony dialog box, refer to the explanations 

following Figure 30.  

4. Click Sign. The created signature field is electronically signed. 
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Performing a Multi-Page Signature Operation 

You can invoke a series of electronic or digital signature operations. In every step, a new 

signature field is created and signed on the next page, in the same location and size as the 

previous signature. This multi-page signing operation is mostly suitable for contract-type 

documents, where many signatures need to be created in the same location on every page. 

To create a multi-page signature: 

1. Go to the first page that needs to be signed. 

2. Click the down arrow adjacent to the Sign icon . Several options appear 

(Figure 91). 

 

Figure 91  OmniSign ï Signing Options 

3. Select Multi-Page Signatures. 

4. Click the mouse to indicate the top left corner of the new signature field. An empty 

signature field is created, and the Multi-Page Signatures dialog box appears (Figure 92).  

 

Figure 92  Multi -Page Signatures Dialog Box 

5. Optionally drag or resize the empty signature field. 

6. Optionally click Settings to specify signature settings for this signature. 

The Signature Settings window appears (refer to Configuring Default Signature Settings 

for a Single Signature). Edit the settings as desired. For example, specify whether this 

signature is an electronic or a digital signature. 

7. Click Sign. The standard Signing Ceremony dialog box appears (Figure 30). 

a. Select or enter the relevant information in the standard Signing Ceremony dialog box. 

For more information about the standard Signing Ceremony dialog box, refer to the 

explanations following Figure 30. 
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b. Click Sign in the standard Signing Ceremony dialog box. The created signature field 

is signed. If the signature field is an electronic signature field, an electronic signature 

field is created. 

The next page is displayed. 

8. Perform one of the following: 

§ Click Sign to sign this page and display the next page. During this signature 

operation, no Signing Ceremony dialog box appears (unless you clicked Settings, and 

changed a setting in the dialog box or clicked OK). 

§ Click Skip to not sign this page and display the next page. 

At any page, you can also click Settings to change the signature settings from this page 

onwards. If you do so, then the next time you click Sign, the procedure described in 

Step  7 is carried out. 

9. At every page, perform the actions described in Step  8.  

10. Click Done to end the multi-page signature operation. 

Saving the Signed File 

To save the signed PDF document, select File Ą Save. The current PDF document is saved 

into the default location. If the original file is a non-PDF file, you are prompted to provide a 

location. 

After saving, you can email the file from within OmniSign by selecting File Ą Attach to 

email. A new mail message is created with the signed file already attached, with the subject 

being the signed file name. 

Validating All Signatures 

To validate all signatures, click  in the toolbar, or select Signatures Ą Validate all 

Signatures. 

The Signature Panel displays the validity status of each signature. In the main window, a valid 

signature appears with a green check mark, an invalid signature appears with a red cross mark, 

and an unknown (not yet validated) signature appears with no indication. 
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Viewing Signature Details 

The Signatures panel lists all the digital signature fields inside the PDF document.  

 

Figure 93  OmniSign Signatures Panel 

The list first displays all signed fields in the order of their signature time. It then displays all 

non-signed fields in the order of their creation date, listing the field name of each one. For 

every signed field the following information is displayed: 

§ Signer name and graphic indication of signature validation status. 

§ Signature validation status ï Valid, Invalid, or Unknown (not yet validated). 

§ Signature time. 

§ Reason ï If entered. 

For every signature field there is a list of available operations, depending on whether the field 

is signed or not. The available operations are the same as the operations available in the 

signature fieldôs right-click menu (for a full list, refer to Performing Operations on a Single 

Signature Field). The only additional operation is Go to Signature, which is disabled for 

invisible signatures.  
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Performing Operations on a Single Signature Field 

You can perform various operations on a single signature field. These operations are available 

in any of the following ways: 

§ Clicking the Options drop down menu appearing just above the signature field 

(Figure 90) 

§ Right-clicking a signature field 

§ Left-clicking a signature field in the Signatures panel (Figure 93).  

The available operations include: 

§ Sign ï Signs or re-signs the signature field. The Signing Ceremony dialog appears 

(Figure 30). Select or enter the relevant information and click Sign.  

§ Certify ï Performs a PDF signature operation that is ñstrongerò than the regular PDF 

signature operation (as described in Certifying an Adobe Acrobat Document). When a 

document is certified, you can specify one of the following certification modes: 

§ No further changes allowed ï No changes are permitted to the PDF document. 

§ Form filling & signing allowed ï You may enter data in forms, and sign existing 

signature fields in the PDF document. 

§ Annotations, form filling & signing allowed ï You may add annotations to the 

document, enter data in forms, and sign existing signature fields in the PDF document. 

The Certify  operation is disabled if there is a signed field in the document. 

§ Validate ï Validates the digital signature. The display of the signature in the main screen 

is refreshed to reflect the validation state of the signature.  

§ Clear ï Clears the digital signature. This results in an empty signature field.  

§ Remove ï Removes the digital signature as well as the signature field from the document. 

This operation is disabled if there is a signed field in the document. 

§ Settings ï Displays the signature settings. Signature Settings can be changed if the field is 

not signed. This operation is disabled if there is a signed field in the document. 

§ Details ï Displays the digital signature status and certificate status. 
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Configuring Default Signature Settings 

You can configure default signature settings that will apply to newly created signatures. To 

configure the default signature settings for an individual signature field, refer to Configuring 

Default Signature Settings for a Single Signature. 

To configure default signature settings for all signatures: 

1. Click  in the toolbar, or select Tools Ą Settings. The OmniSign Settings dialog box 

appears. The settings you configure will apply to all newly created digital or electronic 

signatures.  

2. Click the Digital Signature tab to configure the default digital signature settings. 

 

Figure 94  OmniSign Default Signature Settings ï Digital Signatures 

3. View the current settings, or change the settings as desired. For an explanation of the 

available fields, refer to Configuring the Signature General Parameters and Configuring 

the Signature Appearance. 

4. Click the Electronic Signature tab to configure the default electronic signature settings. 
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Figure 95  OmniSign Default Signature Settings ï Electronic Signatures 

5. View the current settings, or change the settings as desired. For an explanation of the 

available fields, refer to Configuring the Signature General Parameters and Configuring 

the Signature Appearance. 

6. Click the General tab to configure the default general signature settings. 
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Figure 96  OmniSign Default Signature Settings ï General 

In the General tab you can configure:  

§ General settings ï Refer to Configuring General OmniSign Settings. 

§ Saving Options ï Refer to Configuring OmniSign Saving Options. 

§ Signature Date & Time format ï refer to Configuring Date and Time Format 

Configuring General OmniSign Settings 

You can configure the following general OmniSign settings (Figure 96): 

§ Show tips at startup ï Specify whether OmniSign will display a tip popup (Figure 97) 

upon startup. 
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Figure 97  Tip Popup 

§ Open new documents in same window ï Specify whether every activation of OmniSign 

(via the OmniSign Printer, the Sign with CoSign right-click option, or the CoSign Control 

Panel) will be diverted to the same running instance of OmniSign. 

§ Verify signatures when documents are opened ï Specify whether OmniSign will 

validate all digital signatures upon opening a PDF file. 

§ One-touch signature ï Specify whether the user only needs to left-click once in a 

document displayed in the main window to indicate the center of a new digital or 

electronic signature field. The width and height of the signature field are determined by 

the values you enter in the Width and Height fields.  

§ Width and Height ï Specify the width and height of a one-touch signature field, in 

points. 

The fields right under Width and Height display the width and height in the units 

selected in Measurement Units. Both sets of width and height fields, as well as the 

Measurement Unit field, are linked. That is, a change in one of them automatically 

causes an alteration in the fields influenced by the change.  

§ Measurement units ï Select the unit of measurement for the fields directly under 

Width and Height.  

Configuring OmniSign Saving Options 

 

Figure 98  Saving Options 
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You can configure the following save options: 

§ Default folder ï Specify the folder where the signed PDF file will be stored. The file 

name is identical to the name of the original file if the original file is a PDF file. Do not 

change this field, unless you are batch signing a group of files. If you do not change this 

field, OmniSign will overwrite the source PDF file with the signed PDF file, or prompt 

you for a location if the source file is a non-PDF file. 

§ Delete original ï Specify whether to delete the original file after the signature operation. 

This option is relevant only if the signed file is saved in a different location and thus does 

not overwrite the original PDF file. 

Configuring Default Signature Settings for a Single Signature 

To configure signature default settings for an individual signature: 

1. Insert a new digital signature field as described in Inserting a Digital Signature Field. 

2. Select Settings from the Options drop down menu appearing just above the signature 

field (Figure 90). The Signature Settings dialog box appears. 

 

Figure 99  Default Signature Settings 










































































































































